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Overview 
A VERICUT software installation is typical of any other software installation on your 
computer. You simply follow the onscreen instructions for the software components 
you wish to install and where you want them installed on your PC. The software can be 
installed on as many PC’s as you like. The number of licenses available determine how 
many of the copies can be run simultaneously. VERICUT and its features are managed 
through the license manager. This document applies to VERICUT Verification and 
VERICUT Drilling and Fastening (VDAF) 

Considerations before Installation 
VERICUT installation is very simple but you need to know a few things prior to installing 
your software. Some of the menu options you’ll see during the installation require you 
to know what VERICUT products you purchased so you know what to select during the 
installation process. If you are planning on installing the license server please note that 
you must have administrator privileges to perform the license server configuration. You 
must also have administrator privileges to install the Microsoft redistributable run-time 
libraries if necessary. It’s also possible that the windows security settings on your PC will 
require administrative privileges to install the base software also. Check with your IT 
administrator about your security settings prior to attempting installation. 
 
Take a look at the pc requirements and the licenser server configuration before 
installing the software. (click on the links below) 
 

PC requirements 
 
License Server 

 
Terminology 

Client Computer — The computer that runs the VERICUT software. 

License Server Computer — The computer running the license server program. It 
may also run the VERICUT client software concurrently  

License Server Program — The program providing licenses for VERICUT. VERICUT 
requires a license, so the License Server Program must be running for VERICUT to 
operate. VERICUT uses the Sentinel RMS license server program from SafeNet. The 
license server program and VERICUT communicate using TCP/IP network protocol. 
Only one Sentinel RMS license server program may run on a computer. 

 
 

http://www.safenet-inc.com/software-monetization/sentinel-rms/
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Installation from a DVD 
Insert the DVD into the Drive and follow the onscreen instructions. This method of 
installation is now outdated. 

 

Installing from a downloaded Zip file 
You can request a download of the VERICUT installation files from the CGTech website.  
 
http://www.cgtech.com/vericut_support/request-software-update 
 
Once you downloaded the zip file you’ll need to unzip it to a temporary folder. While 
unzipping the file you’ll be prompted for a password. This password will be in the email 
that was sent to you for the download link. 
 
From the temporary folder where you unzipped your installation, double click (or right 
click, open) on the setup.exe. Next, follow the on-screen instructions 

  

http://www.cgtech.com/vericut_support/request-software-update
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Basic VERICUT Product Installation     
 
Run the setup.exe from the folder containing the downloaded installer. 
 
 
 
 
 
Select the desired 
language from the 
dropdown list at 
the bottom and 
click on the OK 
button. 

  
 
 

 

 

 

The Introduction 
page will be 
displayed. Click the 
“Next” button to 
continue. 
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The license 
agreement page will 
then be displayed. 
 
Read the license 
agreement. 
 
If you agree, select 
the “I accept the 
terms and 
conditions” 
 
Click the “Next” 
button to continue. 
 
 
 

 

 
 
 
 

 
The folder location 
will then be 
displayed. 
 
Accept the default 
location or browse 
for a different 
location. 
 
When you’re 
satisfied with the 
location, click the 
“Next” button to 
continue   
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Choose your 
installation options. 

  
 

Full installs the product, license server, help, samples and training files. This is the 
recommended setting. 

Partial installs the product, license server and help files. 

Custom allows you individually to choose which items get installed. 

 
If you’ve chosen 
the Custom option 
the next screen will 
allow you to select 
which components 
of the product to 
install. Make your 
selections and click 
the “Next” button 
to continue. 
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Choose which 
license server to 
access. 
 
• Use Existing 

License server 
on Remote 
Computer.  

 
• The Use Existing 

License server 
on this  

 

• Install a license 
server on this 
computer. 
(NOTE: 
installing new 
license server 
requires 
administrative 
privileges)  

 
Click the “Next” 
button to continue. 
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Shortcut 
Locations 

 

Choose where 
you want you 
shorts to be 
located. On the 
Desktop, in your 
Quick Launch bar 
or in a program 
group in your 
start menu. You 
may select as 
many of these 
option as you 
want. 

 

NOTE: It is 
recommended 
that you always 
keep the 
program group 
as a selection. 
The group in the 
start menu will 
contain several 
utilities that 
you may wish to 
access later 
on.  

 

Click the “Next” 
button to 
continue 
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VERICUT Product 
Shortcuts 
 
Select which 
product(s) you which 
to install and create 
shortcuts for. 
 
Make sure you know 
which products you 
purchased prior to 
making your 
selection.  

 

Click the “Next” 
button to continue. 
 

 

 

Defaults Units 
 
Choose the default 
units to use when 
opening VERICUT.  
 
During normal 
VERICUT operation, 
the units can also be 
selected when 
starting a new 
project. 
 
Once a unit has been 
selected it’s saved 
with the project file. 
 

Click the “Next” 
button to continue. 
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Select which Help 
Documentation you 
would prefer: Online 
or Local. 
 
Click the “Next” 
button to continue 
  
 
 
 
 
 
 
Select Additional 
interfaces. 
 
If you purchased 
additional interfaces 
in the list, select 
them to have them 
installed.  
 
 
NOTE: there may be 
more options 
available than this 
image depicts. 
 
 
Click the “Next” 
button to continue 
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If you selected the 
Esprit interface you 
will be prompted for 
the location of the 
Esprit installation. If 
it’s not the default 
installation listed 
then click on the 
“Choose” button to 
locate the Esprit 
installation. 

 
 
 

 
 
 

If you selected the 
EdgeCam interface 
you’ll be prompted to 
select the installation 
directory. 

 
 

 
If you selected the 
Mastercam interface 
you’ll be prompted to 
select the installation 
directory. 
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The Summary page 
will then be 
displayed. 
 
Review your choices. 
If you need to go 
back and make any 
changes click on the 
“Previous” button to 
return to the topic 
that needs a 
correction. 
 
Clicking the “Install” 
button will begin the 
installation process. 
 
 

 

The installation 
progress screen will 
be displayed during 
the installation. 

 
 
 



Installing CGTech Products 

13 

Once the installation 
is completed a 
window will be 
displayed asking if 
you would like to 
view the post-
installation 
instructions. This will 
launch your browser 
and provide a link to 
take you to the 
CGTech website to 
the on-line post-
installation 
instructions. 
 
If you wish to install a 
license server on this 
PC then check the 
box and click next. 
 
 

 

Click the “Done” 
button to exit the 
Installer.  
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If you opted to install 
the license server, 
click next to 
continue. 

 
 

Click on the accept 
button and then click 
next to continue 

 
 

Choose a new 
location or click next 
to accept the default 
location to continue. 
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Check the program 
group option 
(recommended) to 
create a program 
group in the start 
menu. 

This group contains 
additional utilities for 
configuring the 
license server as 
shown on the next 
page.  

 
This picture shows 
the additional  
utilities available 
when available  
using the program 
group option. 

 
 
 

The pre-installation 
page is now 
displayed. Examine 
the install options 
selected. If necessary, 
click the previous 
button to go back 
and change any 
options otherwise 
click next to continue 
the installation. Click 
Done when the 
installation is 
completed. 
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Basic License Server Configuration 
 
NOTES FOR EXISTING USERS 
 
The license file manager from the VERICUT 9.3.2 installation must be installed (Sentinel 
version 9.8.1). Prior versions of the Sentinel License Server are not compatible with the 
new license file format.  
 
In addition, those running the Sentinel License Server on a Virtual Machine must 
specifically request a Virtual Machine Enabled license file from CGTech. Attempting to 
run a VM disabled license from a Virtual Machine will result in error. 

 
 
This set of instructions assumes that you have a standard Windows network 
configuration with TCP/IP. You must have administrative privileges in order to install the 
license server or the Microsoft redistributables. 
 
 
Before you can install and configure the license manager service you must first obtain a 
license file email from CGTech. If you’re a new user of VERICUT you can go to the 
CGTech website to request your license file. Before going to the website to request your 
license, you need to be prepared to provide your 6 digit company ID, your Host Name 
(name of the server or PC running the license manager) and  the Host ID (the 12 digit 
MAC address of the server or PC running the license manager). 
 
If you don’t know your 6 digit company ID you can contact you CGTech Sales engineer or 
the technical support department 
 
You can locate your host name by opening control panel and selecting System. The host 
name is the Computer name. 
 
 
 
 
 
You can determine your Host ID by running the HOST 
ID utility from the start menu. This will display a 
command window with 1 or more 12 digit Ethernet 
addresses. Choose an address from the list. 
 
Example: 
 
Ethernet 1: 0001CF45A789 
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Ethernet 2: 2001BC23B123 
 
 
Once you have this information you can go to the CGTech website and complete the 
license request form. The form will be sent to the email address you specified on the 
form. 
 
http://www.cgtech.com/vericut_support/request-license 
 
 
Once you have your license file email available, proceed with the following steps. 
 
 
Go to the start menu and select the VERICUT license folder 
that was created during the installation process 
 
Next, select the license server only folder and then select 
Configure License and Setup Server. This utility performs 
the following tasks. 
 
 
 

 
1. Creates a license file from your license email 
2. Sets the LSERVOPS environment variable to point to 

your new license file location. 
3. Stops the existing server if one exists 
4. Removes the existing license server service. 
5. Installs the new license server service. 
6. Updates the new license server service with the new license file features. 

 
 
If you get any errors during this process please go to the trouble shooting section.  
  

http://www.cgtech.com/vericut_support/request-license
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If no errors are generated then run the Sentinel LM License 
Administrator (wlmadmin.exe) from the start menu, 
VERICUT Installation, License Administration.  
 
 
 
 
When the license administrator launches, expand out the subnet servers (+) and then 
expand out the computer name. You should see all you license features appear. 
Selecting the license feature in the list will display the name of the feature and how 
many license of the feature you have available.  
 

 
 
At this point the client PC’s should be able to run VERICUT. If VERICUT fails to launch, 
take note of the error message and go to the trouble shooting section of this guide. 
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Choose an Installation Configuration 
 

There are several different ways to configure your VERICUT software installation. The 
following are common configurations: a simple single computer or stand-alone 
installation and multiple-computer installations. 

 

 
Both the License Server and the VERICUT software run on the same computer 

 

 
 

License server running on a different PC on the network 

(NOTE: The license server computer may also run the VERICUT application) 

(Back to Things to Consider Before Installation) 
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VERICUT System Requirements 
Version 9.3.2 
 
When considering system requirements you need to consider all the tasks it will be 
performing. For the purposes of discussion, we’ll only reference 64 bit CPU’s and 
operating systems. VERICUT Version 9.3.2 supports only 64 bit CPU’s and operating 
systems.  
                                                                          
Considerations: 

1) What is the physical size of the part you will simulate? 
2) What other software applications are running while VERICUT is running? 
3) What requirements do the other applications have (both memory and graphics)? 

 
VERICUT performance is primarily affected by the simulation tolerances used and the 
speed of the CPU’s. The faster the CPU speed, the faster your programs will run. The 
length of part programs being simulated does not affect VERICUT speed.  
 
The link below takes you to the Intel site where you can review the current CPU’s 
available and read up on some of the latest CPU technology.     
 
http://www.intel.com/content/www/us/en/processor-comparison/compare-intel-
processors.html?select=desktop 
 
 

IMPORTANT!   Always check the latest system requirements, available at VERICUT 
System Requirements webpage. 

 

NOTE:   Requirements have changed – review carefully 

 

Windows 64 bit Requirements  

OS Windows 10 64-bit Professional 

Processor Intel i7 or Xeon 

Memory 16 GB or higher at minimum, 32 GB is recommended 

http://www.intel.com/content/www/us/en/processor-comparison/compare-intel-processors.html?select=desktop
http://www.intel.com/content/www/us/en/processor-comparison/compare-intel-processors.html?select=desktop
http://www.cgtech.com/vericut_support/system-requirements/
http://www.cgtech.com/vericut_support/system-requirements/
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Video AMD Radeon RX with 2 GB GPU RAM or higher 

NVIDIA GeForce with 2 GB GPU RAM or higher 
  

Monitor  1920 x 1080 (or higher) resolution, dual monitor 

Storage  Solid State Drive (SSD) with at least 50 GB free, 75 GB is 
recommended 

Pointing Device Three buttons with mouse-wheel (3Dconnexion Space Mouse 
supported) 

 
 
 

Basic Troubleshooting 
 

Errors Running Vericut 
 
“Error No License Server Found” 
Cause - The license server is not running. 
 
Solution – Start the license server utility. Make sure the license server is installed 
NOTE: loading or stopping/starting the license server requires administrative privileges.   
 
Cause - The server name is incorrect 
 
Solution – From the start menu, CGTech program group, license administration, run the 
“Specify License Server Computer” utility. This will allow you to edit the LSHOST variable 
with the correct server name or IP address. 
 
 
“License server found but invalid version number” 
Cause – Typically this is caused by an older license file being 
 
Solution – Ensure that the license file being used is for 9.3.2 
Check the lservops environment variable to be sure that it points to the correct location 
for the 9.3.2 license file. Either edit the LSERVOPS variable or move the license file to 
the correct location. 
NOTE: editing the LSERVOPS variable requires administrative privileges. 
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“Unable To Access Shared Library” 
Cause – Missing the Microsoft redistributables. 
 
Solution – run the vcredist_* executables from the redist folder of your VERICUT 
installation or from the redistributables folder of your VERICUT Installation folder.  
NOTE: running these files requires administrative privileges. 
 
 
 
“Error Loading ACIS Libraries” 
Cause - Model interfaces not installed 
 
Solution – Run the Model Interfaces Executable from the installation folder. 
(model_interfaces_v73.exe) 
 
Cause - Missing the Microsoft redistributables. 
 
Solution – run the vcredist_* executables from the redist folder of your VERICUT 
installation or from the redistributables folder of your VERICUT Installation folder.  
NOTE: running these files requires administrative privileges. 
 
 
“License server found but features not present” 
Cause – Firewall or anti-virus is blocking communication between the license server and 
the client running VERICUT. 
 
Solution – Open up the firewall / anti-virus utility and add exceptions for port 5093 as 
well as lservnt.exe. 
 
 

Errors Installing the Sentinel License Server 

 
“Cannot Communicate with License server” 
Cause - Missing the Microsoft redistributables. 
 
Solution – run the vcredist_* executables from the redist folder of your VERICUT 
installation or from the redistributables folder of your VERICUT Installation folder.  
NOTE: running these files requires administrative privileges. 
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“Sentinel RMS Development Kit: Error[150] The specified lock code is invalid 
Cause – MAC address in license file does not match MAC address on the server 
 
Solution – Move the license server to the correct computer or request a new license file 
with the correct MAC address. To request a new license file you must fill out a license 
transfer request online at: 
  
http://www.cgtech.com/vericut_support/request-license/transfer-request/ 
 
 
Error license file cgtech.lf does not exist 
Cause – The update batch file cannot locate the cgtech.lf  license file. 
 
Solution – Make sure the cgtech.lf was created in the license folder of your VERICUT 
installation. Ensure that you have write permissions for this folder. 
 
 

Other Installation Types 
 

Install VERICUT License Server Only 
 
It may be desirable to install only the license server program on the license server 
computer. To do this, run the “license_server_install.exe” from the download folder. 
 
 
 

 

  

http://www.cgtech.com/vericut_support/request-license/transfer-request/
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Using Silent Install 
 

Silent Mode 

Silent mode enables an installer to run without any user interaction on Windows 
platforms. If you choose to run this option, there will be no console or GUI output 
during installation. Silent mode supports the setting of a target directory, shortcuts 
directory, and Components/Features via either command-line arguments or a 
properties file. Silent mode is supported in both the installer and uninstaller runtime 
environments. InstallAnywhere and end-user-defined variables may be set through 
command-line parameters and/or a properties file.  

An installer properties file or a command-line parameter may trigger silent mode.  

  

Installer Properties File 

An installer properties file is an ASCII text file that defines certain parameters for your 
installation. This may be useful if you have a complex project that you are installing both 
internally and externally. Your internal end-users do not need to see panels such as the 
License Agreement panel. The properties file is an ideal way to turn panels on or off 
depending on your specific needs. In addition, the properties file can define the type of 
installation you want to run, such as console or silent.  

NOTE:  Please make sure that your properties file ends in .properties, not .txt. 

  

Tip:  If the install.properties file is in the same directory as your installer, it will be 
invoked automatically. However, if it is in a different directory or a different name, you 
may use the following command line option to direct it to the relative path: 

 C:\\ <path to the installer> -f <path to the properties file> 

  

Command Line Parameter 

To call the properties file from the command line, type the following command: 

install.exe -f <properties file> 

You may use the direct or the relative path to the properties file.  

InstallAnywhere variables may be incorporated in these values, and they will be 
resolved at install time. 
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NOTES:  
1. File separators should be denoted by the “\\”.  

2. Values may ignore case. 

3. Silent mode will override action panel values. 

4. In any mode on Windows systems, installers and uninstallers will always display 
the very last "Cleaning-up" dialog box, as well as the "Preparing to install" panel.  

  

VERICUT Properties File Variables 

An example of an install.properties file with all parameters is as follows 

 

#INSTALLER GUI? Silent, Console, GUI 
#--------------------- 
INSTALLER_UI=Silent 
 
#Choose Install Folder 
#--------------------- 
USER_INSTALL_DIR=C:\\Program Files\\CGTech\\VERICUT 9.3.2 
 
#Choose Type of Installation 
#--------------------------- 
CHOSEN_FEATURE_LIST=VERICUT,Help,Samples 
CHOSEN_INSTALL_FEATURE_LIST=VERICUT,Help,Samples 
CHOSEN_INSTALL_SET=Full 
 
#License Server Location 
#----------------------- 
LICENSE_SERVER_EXISTS_REMOTE=1 
LICENSE_SERVER_EXISTS_REMOTE_HOSTNAME=LicenseServer 
LICENSE_SERVER_EXISTS_LOCAL=0 
LICENSE_SERVER_INSTALL_LOCAL=0 
 
#VERICUT Shortcut Locations 
#-------------------------- 
USER_INPUT_DESKTOP_FLAG=1 
USER_INPUT_QUICK_LAUNCH_FLAG=1 
USER_INPUT_PROGRAM_GROUP_FLAG=1 
USER_INPUT_PROGRAM_GROUP_NAME=CGTech VERICUT 9.3.2 
USER_INPUT_ALL_USERS_FLAG=0 
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#VERICUT Product Shortcut 
#------------------------ 
# "1) VERICUT" 
DEFAULT_BASE_LIC_VAR_1=1 
# "2) VERICUT Single Platform" 
DEFAULT_BASE_LIC_VAR_2=1 
# "3) Reviewer" 
DEFAULT_BASE_LIC_VAR_3=1 
# "4) VERICUT Drilling and Fastening (VDAF)" 
DEFAULT_BASE_LIC_VAR_4=1 
# "5) ToolMan" 
DEFAULT_BASE_LIC_VAR_5=1 
 
#VERICUT Default Units 
#--------------------- 
DEFAULT_UNITS_VAR=\"1) Inch\",\"\" 
DEFAULT_UNITS_VAR_1=1) Inch 
DEFAULT_UNITS_VAR_2= 
 
#VERICUT Interfaces 
#------------------ 
 
#Install Complete 
#---------------- 

 
The above sample will install an Inch version of VERICUT and create shortcuts for 
VERICUT, SP, Reviewer and ToolMan.  
 

 
Below is a list of possible variable: 
 
 

#INSTALLER GUI? Silent, Console, GUI 
#--------------------- 
INSTALLER_UI=Silent 
 
#Choose Install Folder 
#--------------------- 
USER_INSTALL_DIR=C:\\Program Files\\CGTech\\VERICUT 9.3.2 
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#Choose Type of Installation 
#--------------------------- 
CHOSEN_FEATURE_LIST=VERICUT,Help,Samples 
CHOSEN_INSTALL_FEATURE_LIST=VERICUT,Help,Samples 
CHOSEN_INSTALL_SET=Full 
 
#License Server Location 
#----------------------- 
LICENSE_SERVER_EXISTS_REMOTE=1 
LICENSE_SERVER_EXISTS_REMOTE_HOSTNAME=LicenseServer 
LICENSE_SERVER_EXISTS_LOCAL=0 
LICENSE_SERVER_INSTALL_LOCAL=0 
 
#VERICUT Shortcut Locations 
#-------------------------- 
USER_INPUT_DESKTOP_FLAG=1 
USER_INPUT_QUICK_LAUNCH_FLAG=1 
USER_INPUT_PROGRAM_GROUP_FLAG=1 
USER_INPUT_PROGRAM_GROUP_NAME=CGTech VERICUT 9.3.2 
USER_INPUT_ALL_USERS_FLAG=0 
 
#VERICUT Product Shortcut 
#------------------------ 
# "1) VERICUT" 
DEFAULT_BASE_LIC_VAR_1=1 
# "2) VERICUT Single Platform" 
DEFAULT_BASE_LIC_VAR_2=1 
# "3) Reviewer" 
DEFAULT_BASE_LIC_VAR_3=1 
# "4) VERICUT Drilling and Fastening (VDAF)" 
DEFAULT_BASE_LIC_VAR_4=1 
# "5) ToolMan" 
DEFAULT_BASE_LIC_VAR_5=1 
 
#VERICUT Default Units 
#--------------------- 
DEFAULT_UNITS_VAR=\"1) Inch\",\"\" 
DEFAULT_UNITS_VAR_1=1) Inch 
DEFAULT_UNITS_VAR_2= 
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#VERICUT Interfaces 
#------------------ 
SPATIAL_INSTALL=1 
ESPRIT_INTERFACE_INSTALL=1 
EDGECAM_INTERFACE_INSTALL=1 
EDGECAM_2017_R2_SU3_SELECTED=1 
EDGECAM_2017_R2_SU1_SELECTED=1 
EDGECAM_2017_R1_SELECTED=1 
EDGECAM_2016_R2_SELECTED=1 
EDGECAM_2016_R1_SU1_SELECTED=1 
EDGECAM_2015_R2_SELECTED=1 
EDGECAM_2015_R1_SELECTED=1 
EDGECAM_2014_R2_SU2_SELECTED=1 
EDGECAM_2014_R1_SELECTED=1 
EDGECAM_2013_R2_SELECTED=1 
EDGECAM_2013_R1_SELECTED=1 
MASTERCAM_INTERFACE_INSTALL=1 
MASTERCAM_2018_SELECTED=1 
MASTERCAM_2017_SELECTED=1 
MASTERCAM_X9_SELECTED=1 
MASTERCAM_X8_SELECTED=1 
MASTERCAM_X7_SELECTED=1 
MASTERCAM_X6_SELECTED=1 
 
 
#Choose Esprit Folder 
#-------------------- 
ESPRIT_INSTALL_DIR=C:\\Program Files\\D.P.Technology\\ESPRIT 
 
#Choose Edgecam 2013 R1 Folder 
#----------------------------- 
EDGECAM_2013_R1_INSTALL_DIR= C:\\Program Files\\Planit\\Edgecam 2013 R1 
 
#Choose Edgecam 2013 R2 Folder 
#----------------------------- 
EDGECAM_2013_R2_INSTALL_DIR= C:\\Program Files\\Planit\\Edgecam 2013 R2 
 
#Choose Edgecam 2014 R1 Folder 
#----------------------------- 
EDGECAM_2014_R1_INSTALL_DIR= C:\\Program Files \\Planit\\Edgecam 2014 
R1 
 

  

file://Planit/Edgecam
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#Choose Edgecam 2014 R2 SU2 Folder 
#--------------------------------- 
EDGECAM_2014_R2_SU2_INSTALL_DIR= C:\\Program Files\\Planit\\Edgecam 
2014 R2 SU2 
 
#Choose Edgecam 2015 R1 Folder 
#----------------------------- 
EDGECAM_2015_R1_INSTALL_DIR= C:\\Program Files\\Planit\\Edgecam 2015 R1 
 
#Choose Edgecam 2015 R2 Folder 
#----------------------------- 
EDGECAM_2015_R2_INSTALL_DIR=C:\\Program Files\\Vero Software\\Edgecam 
2015 R2 
 
#Choose Edgecam 2016 R1 SU1 Folder 
#--------------------------------- 
EDGECAM_2016_R1_SU1_INSTALL_DIR=C:\\Program Files\\Vero 
Software\\Edgecam 2016 R1 SU1 
 
#Choose Edgecam 2016 R2 Folder 
#----------------------------- 
EDGECAM_2016_R2_INSTALL_DIR=C:\\Program Files\\Vero Software\\Edgecam 
2016 R2 
 
#Choose Edgecam 2017 R1 Folder 
#----------------------------- 
EDGECAM_2017_R1_INSTALL_DIR=C:\\Program Files\\Vero Software\\Edgecam 
2017 R1 
 
#Choose Edgecam 2017 R2 SU1 Folder 
#--------------------------------- 
EDGECAM_2017_R2_SU1_INSTALL_DIR=C:\\Program Files\\Vero 
Software\\Edgecam 2017 R2 SU1 
 
#Choose Edgecam 2017 R2 SU3 Folder 
#--------------------------------- 
EDGECAM_2017_R2_SU3_INSTALL_DIR=C:\\Program Files\\Vero 
Software\\Edgecam 2017 R2 SU3 
 
#Choose Mastercam 2018 Folder 
#---------------------------- 
MASTERCAM_2018_PATH=C:\\Program Files\\Mcam\\mcam2018 
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#Choose Mastercam 2017 Folder 
#---------------------------- 
MASTERCAM_2017_PATH=C:\\Program Files\\Mcam\\mcam2017 
 
#Choose Mastercam X9 Folder 
#-------------------------- 
MASTERCAM_X9_PATH=C:\\Program Files\\Mcam\\mcamx9 
 
#Choose Mastercam X8 Folder 
#-------------------------- 
MASTERCAM_X8_PATH=C:\\Program Files\\Mcam\\mcamx8 
 
#Choose Mastercam X7 Folder 
#-------------------------- 
MASTERCAM_X7_PATH=C:\\Program Files\\Mcam\\mcamx7 
 
#Choose Mastercam X6 Folder 
#-------------------------- 
MASTERCAM_X6_PATH=C:\\Program Files\\Mcam\\mcamx6 
 
#Install Complete 
#---------------- 

            USER_SHOW_INSTALL_NOTES=0 
RUN_LICENSE_SERVER_INSTALL=0 

 

 

VERICUT Command Descriptions  
 
Specify Silent Install 

INSTALLER_UI=Silent 
Use to specify that Silent install is to be used. 
 
 
Choose Installation Folder 

USER_INSTALL_DIR=insert destination path here 
Use to specify the path to the VERICUT installation folder. 

Example: 
USER_INSTALL_DIR=C:\\Program Files \\CGTech\\VERICUT 9.3.2 
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Choose Type of Installation 

CHOSEN_INSTALL_SET=option 

Use to specify which features are to be installed. Select one of the following options. 

Full – VERICUT Product, Help, Sample and Training files will be installed. 
Partial – VERICUT Product and Help files will be installed. 

If either of the above options (Full or Partial) is used, no other commands are 
needed to specify the features to be installed. 

Example: 

CHOSEN_INSTALL_SET=Full 

Custom – Use this feature to select a “custom” group of features to be installed. Use 
the CHOSEN_INSTALL_FEATURE_LIST command, defined below, to specify the 
features that are to be installed. 
 

CHOSEN_INSTALL_FEATURE_LIST=feature list 

Use to specify the “custom” list of features to be used for the 
CHOSEN_INSTALL_SET=Custom command described above. Choose one or more of the 
following: 

 VERICUT – The VERICUT Product will be installed. 
 Help Files – The Help files will be installed. 
 Sample and Training Files – The Sample and Training files will be installed. 
 

 Example: 

The following commands will install the VERICUT Product and the Sample and 
Training files. 

 CHOSEN_INSTALL_SET=Custom 
 CHOSEN_INSTALL_FEATURE_LIST=VERICUT, Sample and Training Files 
 
 
License Server Location 

You can only use one of the following options:  LICENSE_SERVER_EXISTS_REMOTE, 
LICENSE_SERVER_EXISTS_LOCAL, or LICENSE_SERVER_INSTALL_LOCAL. 
 
LICENSE_SERVER_EXISTS_REMOTE=value 

Use a value of 1 to use an existing license server on a remote computer.  A value of 0 
indicates that this option is not to be used. If the option is not specified, it defaults to 0. 
Use the LICENSE_SERVER_EXISTS_REMOTE_HOSTNAME command, described below, to 
specify the host name of the remote license server computer. 
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LICENSE_SERVER_EXISTS_REMOTE_HOSTNAME=host name 

Used with the LICENSE_SERVER_EXISTS_REMOTE command described above. This 
command is used to specify the license server computer’s host name. 

Example: 

LICENSE_SERVER_EXISTS_REMOTE=1 
LICENSE_SERVER_EXISTS_REMOTE_HOSTNAME=LicenseServer 

 
LICENSE_SERVER_EXISTS_LOCAL=value 

Use a value of 1 to use an existing license server on this computer. A value of 0 indicates 
that this option is not to be used. If the option is not specified, it defaults to 0. 

LICENSE_SERVER_INSTALL_LOCAL=value 

Use a value of 1 to install a License Server on this computer. A value of 0 indicates that 
this option is not to be used. If the option is not specified, it defaults to 0. 

The license server installation starts after the VERICUT installation finishes. Have your 
license email for this computer and version available. 

NOTE:  The use of this option requires that you are an “Administrator” user. 
 
 
VERICUT Shortcut Locations 

USER_INPUT_DESKTOP_FLAG=value 
The USER_INPUT_DESKTOP_FLAG variable is used for adding icons to the Desktop. A 
value of 0 does not add any icons to the Desktop. A value of 1 adds icons to the Desktop. 
If the option is not specified, it defaults to 0. 
 
USER_INPUT_QUICK_LAUNCH_FLAG=value 
The USER_INPUT_QUICK_LAUNCH_FLAG variable is used for adding icons to the Quick 
Launch taskbar. A value of 0 does not add any icons to the Quick Launch taskbar. A value 
of 1 adds icons to the Quick Launch taskbar. If the option is not specified, it defaults to 
0. 
 
USER_INPUT_PROGRAM_GROUP_FLAG=value 
The USER_INPUT_PROGRAM_GROUP_FLAG variable is used for adding icons and menus 
to the Programs Menu. A value of 0 does not add any icons or menus to the Programs 
Menu. A value of 1 adds icons and menus to the Programs Menu. If the option is not 
specified, it defaults to 0. 
 
USER_INPUT_PROGRAM_GROUP_NAME=name of program group  
The USER_INPUT_PROGRAM_GROUP_NAME variable indicates the name of the 
Program Group that is to be added to the Start > All Programs menu. If the option is not 
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specified, it defaults to "CGTech VERICUT x.x.x", where x.x.x is the current VERICUT 
version number. 
 
USER_INPUT_ALL_USERS_FLAG=value 
The USER_INPUT_ALL_USERS_FLAG variable indicates if any icons added by the previous 
three options are added for all users of the computer or only the current user. A value 
of 0 adds icons for the current user only. A value of 1 adds icons for all users. If the 
option is not specified, it defaults to 0. 

NOTE:  The use of this option requires that you are an “Administrator” user. 
 
 
VERICUT Product Shortcut 

Use to specify the VERICUT Product Shortcut(s) that you would like to be installed in the 
Program Group (CGTech VERICUT 9.3.2) for the current user. 

DEFAULT_BASE_LIC_VAR=string series 
"1) VERICUT" 
"2) VERICUT Single Platform" 
"3) Reviewer" 
"4) VERICUT Drilling and Fastening (VDAF)" 
“5) ToolMan  
 
Example: VERICUT only  
DEFAULT_BASE_LIC_VAR =\”1) VERICUT\",\“,\”,\”,\” 
 
 
VERICUT Default Units 

DEFAULT_UNITS_VAR=string series 
“1) Inch” 
“2) Millimeter” 
 
Example: Inch 
DEFAULT_UNITS_VAR=\"1) Inch\",\"\" 
 
 
VERICUT Interfaces 

SPATIAL_INSTALL=value 
Used to specify if the Spatial software used for the Model Interface option gets installed. 
A value of 0 does not install the Spatial software. A value of 1 installs the Spatial 
software. If the option is not specified, it defaults to 0.  
 
 
ESPRIT_INTERFACE_INSTALL= value 
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Used to specify whether, or not, the Esprit-to-VERICUT Interface gets installed.  A value 
of 0 does not install the Esprit-to-VERICUT Interface. A value of 1 installs the Esprit-to-
VERICUT Interface. If the option is not specified, it defaults to 0.  
 
ESPRIT_INSTALL_DIR=path  
Use to specify the path of an existing Esprit installation folder. 
Typically C:\Program Files (x86)\D.P.Technology\ESPRIT 
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Example: 

The following pair of commands is required to install the Esprit-to-VERICUT Interface 

ESPRIT_INTERFACE_INSTALL=1 
ESPRIT_INSTALL_DIR= C:\Program Files (x86)\D.P.Technology\ESPRIT 

 

 
EDGECAM_INTERFACE_INSTALL=value 
Used to specify whether, or not, the Edgecam-to-VERICUT Interface gets installed.  A 
value of 0 does not install the Edgecam-to-VERICUT Interface. A value of 1 installs the 
Edgecam-to-VERICUT Interface. If the option is not specified, it defaults to 0.  
 
EDGECAM_2013_R1_SELECTED=value 
Use to specify if the EDGECAM 2013 R1 interface is to be installed. A value of 0 does not 
install the interface. A value of 1 installs the interface. If the option is not specified, it 
defaults to 0. 
 
EDGECAM_2013_R2_INSTALL_DIR=path 
Use to specify the path of the EDGECAM 2013 R1 Installation. 
Typically C:\\Program Files (x86)\\Planit\\Edgecam 2013 R1 
 
EDGECAM_2013_R2_SELECTED=value 
Use to specify if the EDGECAM 2013 R2 interface is to be installed. A value of 0 does not 
install the interface. A value of 1 installs the interface. If the option is not specified, it 
defaults to 0. 
 
EDGECAM_2013_R2_INSTALL_DIR=path 
Use to specify the path of the EDGECAM 2013 R2 Installation. 
Typically C:\\Program Files (x86)\\Planit\\Edgecam 2013 R2 
 
EDGECAM_2014_R1_SELECTED=value 
Use to specify if the EDGECAM 2014 R1 interface is to be installed. A value of 0 does not 
install the interface. A value of 1 installs the interface. If the option is not specified, it 
defaults to 0. 
 
EDGECAM_2014_R1_INSTALL_DIR=path 
Use to specify the path of the EDGECAM 2014 R1 Installation. 
Typically C:\\Program Files (x86)\\Planit\\Edgecam 2014 R1 
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EDGECAM_2014_R2_SU2_SELECTED=value 
Use to specify if the EDGECAM 2014 R2 SU2 interface is to be installed. A value of 0 does 
not install the interface. A value of 1 installs the interface. If the option is not specified, 
it defaults to 0. 
 
EDGECAM_2014_R2_SU2_INSTALL_DIR=path 
Use to specify the path of the EDGECAM 2014 R2 SU2 Installation. 
Typically C:\\Program Files (x86)\\Planit\\Edgecam 2014 R2 SU2 
 
EDGECAM_2015_R1_SELECTED=value 
Use to specify if the EDGECAM 2015 R1 interface is to be installed. A value of 0 does not 
install the interface. A value of 1 installs the interface. If the option is not specified, it 
defaults to 0. 
 
EDGECAM_2015_R1_INSTALL_DIR=path 
Use to specify the path of the EDGECAM 2015 R1 Installation. 
Typically C:\\Program Files (x86)\\Planit\\Edgecam 2015 R1 
 
EDGECAM_2015_R2_SELECTED=value 
Use to specify if the EDGECAM 2015 R2 interface is to be installed. A value of 0 does not 
install the interface. A value of 1 installs the interface. If the option is not specified, it 
defaults to 0. 
 
EDGECAM_2015_R2_INSTALL_DIR=path 
Use to specify the path of the EDGECAM 2015 R2 Installation. 
Typically C:\\Program Files (x86)\\Planit\\Edgecam 2015 R2 
 
EDGECAM_2016_R1_SU1_SELECTED= value (0 or 1) 
Use to specify if the EDGECAM 2016 R1 SU1 interface is to be installed. A value of 0 does 
not install the interface. A value of 1 installs the interface. If the option is not specified, 
it defaults to 0. 
 
EDGECAM_2016_R1_SU1_INSTALL_DIR=path 
Use to specify the path of the EDGECAM 2016 R1 SU1 Installation. 
Typically C:\\Program Files (x86)\\Planit\\Edgecam 2016 R1 SU1 
 
EDGECAM_2016_R2_SELECTED=value 
Use to specify if the EDGECAM 2016 R2 interface is to be installed. A value of 0 does not 
install the interface. A value of 1 installs the interface. If the option is not specified, it 
defaults to 0. 
 
EDGECAM_2016_R2_INSTALL_DIR=path 
Use to specify the path of the EDGECAM 2016 R2 Installation. 
Typically C:\\Program Files (x86)\\Planit\\Edgecam 2016 R2 
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Example: 
The following three commands are required to install the Edgecam-to-VERICUT 
Interface. This example is for installing the Edgecam-to-VERICUT Interface for Edgecam 
2016 R2 but is representative of the commands needed for all Edgecam versions. 

EDGECAM_INTERFACE_INSTALL=1 
EDGECAM_2016_R2_SELECTED=1 
EDGECAM_2016_R2_INSTALL_DIR=C:\\Program Files (x86)\\Planit\\Edgecam 2016 R2 
 
 
MASTERCAM_X6_SELECTED= value 
Use to specify if the Mastercam_X6 interface is to be installed. A value of 0 does not 
install the interface. A value of 1 installs the interface. If the option is not specified, it 
defaults to 0. 
 
MASTERCAM_X6_PATH =path 
Use to specify the path of the Mastercam X6 Installation. 
Typically C:\\mcamx6\ 
 
MASTERCAM_X7_SELECTED=value 
Use to specify if the Mastercam_X7 interface is to be installed. A value of 0 does not 
install the interface. A value of 1 installs the interface. If the option is not specified, it 
defaults to 0. 
 
MASTERCAM_X7_PATH =path 
Use to specify the path of the Mastercam X7 Installation. 
Typically C:\\mcamx7\ 
 
MASTERCAM_X8_SELECTED=value 
Use to specify if the Mastercam_X8 interface is to be installed. A value of 0 does not 
install the interface. A value of 1 installs the interface. If the option is not specified, it 
defaults to 0. 
 
MASTERCAM_X8_PATH =path 
Use to specify the path of the Mastercam X8 Installation. 
Typically C:\\mcamx8\ 
 
MASTERCAM_X9_SELECTED=value 
Use to specify if the Mastercam_X9 interface is to be installed. A value of 0 does not 
install the interface. A value of 1 installs the interface. If the option is not specified, it 
defaults to 0. 
 



Installing CGTech Products 

38 

MASTERCAM_X9_PATH =path 
Use to specify the path of the Mastercam X9 Installation. 
Typically C:\\mcamx9\ 
 
MASTERCAM_2017_SELECTED=value 
Use to specify if the Mastercam_2017 interface is to be installed. A value of 0 does not 
install the interface. A value of 1 installs the interface. If the option is not specified, it 
defaults to 0. 
 
MASTERCAM_2017_PATH =path 
Use to specify the path of the Mastercam 2017 Installation. 
Typically C:\\mcam2017\ 
 
Example: 

The following pair of commands is required to install the Mastercam-to-VERICUT 
Interface. This example is for installing the Mastercam-to-VERICUT Interface for 
Mastercam 2017 but is representative of the commands needed for all Mastercam 
versions. 

MASTERCAM_2017_SELECTED=1 
MASTERCAM_2017_PATH = C:\\mcam2017\ 
 
 
Install Complete 

USER_SHOW_INSTALL_NOTES=value 
Use to specify whether or not to show the post-installation configuration instructions. 
This feature displays instructions on how to setup a license server, configure CAD/CAM 
Interfaces, install CAD Model Interfaces or other configuration tasks. A value of 0 does 
not display the post-installation instructions. A value of 1 displays the post-installation 
instructions. If the option is not specified, it defaults to 0. 

 
RUN_LICENSE_SERVER_INSTALL=value 
Use to specify whether or not to run the license server installer. A value of 0 does not 
run the license server installer. A value of 1 runs the license server installer. If the option 
is not specified, it defaults to 0. 
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VERICUT Reviewer Command Descriptions  
 
Specify Silent Install 

INSTALLER_UI=Silent 
Use to specify that Silent install is to be used. 
 
 
Choose Installation Folder 

USER_INSTALL_DIR=destination path 
Use to specify the path to the VERICUT installation folder. 

Example: 
USER_INSTALL_DIR=C:\\Program Files \\CGTech\\VERICUT 9.3.2 
 
 
Choose Reviewer Platform 

Use to specify the VERICUT Reviewer Windows platform that you would like to be 
installed. 

VERICUT_PLATFORMS=string series 

Choose one of the following options. 

Windows 32-bit 
Windows 64-bit 
 
Examples: 

VERICUT_PLATFORMS=\"Windows 32-bit\",\"\" 
VERICUT_PLATFORMS=\"\",\"Windows 64-bit\" 
 
 
VERICUT Reviewer Shortcut Locations 

Use to specify where you would like to create VERICUT Reviewer 9.3.2 shortcut(s) 

USER_INPUT_DESKTOP_FLAG=value 
Use to put a VERICUT Reviewer icon on the Desktop. A value of 0 does not put a 
VERICUT Reviewer icon on the Desktop. A value of 1 puts a VERICUT Reviewer icon on 
the Desktop. If the option is not specified, it defaults to 0. 
 
USER_INPUT_QUICK_LAUNCH_FLAG=value 
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Use to put a VERICUT Reviewer icon in the Quick Launch Bar. A value of 0 does not put a 
VERICUT Reviewer icon in the Quick Launch Bar. A value of 1 puts a VERICUT Reviewer 
icon in the Quick Launch Bar. If the option is not specified, it defaults to 0. 
 
USER_INPUT_PROGRAM_GROUP_FLAG=value 
Use to put a VERICUT Reviewer shortcut in a Program Group. A value of 0 does not put a 
VERICUT Reviewer shortcut in a Program Group. A value of 1 puts a VERICUT Reviewer 
shortcut in a Program Group. If the option is not specified, it defaults to 0. This 
command is used with the USER_INPUT_PROGRAM_GROUP_NAME command described 
below. 
 
USER_INPUT_PROGRAM_GROUP_NAME=program group name 
Use to specify the name of the Program Group that you want a VERICUT Reviewer 
shortcut put in. This command is used with the USER_INPUT_PROGRAM_GROUP_FLAG 
command described above. 
 

USER_INPUT_ALL_USERS_FLAG=value 

Use to specify that specified icons/shortcuts are to be added for all users of this 
computer. 

 

Examples: 

The following command puts a VERICUT Reviewer icon the desktop. 

USER_INPUT_DESKTOP_FLAG=1 
 
The following pair of commands puts a VERICUT Reviewer shortcut in “CGTech VERICUT 
Reviewer 9.3.2” program group. 

USER_INPUT_PROGRAM_GROUP_FLAG=1 
USER_INPUT_PROGRAM_GROUP_NAME = CGTech VERICUT Reviewer 9.3.2 
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Stand-alone Tool Manager Command Descriptions  
 
Specify Silent Install 

INSTALLER_UI=Silent 
Use to specify that Silent install is to be used. 
 
 
Choose Installation Folder 

USER_INSTALL_DIR= destination path 
Use to specify the path to the Stand-alone Tool Manager installation folder. 

Example: 
USER_INSTALL_DIR=C:\\Program Files \\CGTech\\ToolMan 9.3.2 
 
 
License Server Location 

You can only use one of the following options:  LICENSE_SERVER_EXISTS_REMOTE or 
LICENSE_SERVER_EXISTS_LOCAL. 
 
LICENSE_SERVER_EXISTS_REMOTE=value 

Use a value of 1 to use an existing license server on a remote computer.  A value of 0 
indicates that this option is not to be used. If the option is not specified, it defaults to 0. 
Use the LICENSE_SERVER_EXISTS_REMOTE_HOSTNAME command, described below, to 
specify the host name of the remote license server computer. 
 
LICENSE_SERVER_EXISTS_REMOTE_HOSTNAME=host name 

Used with the LICENSE_SERVER_EXISTS_REMOTE command described above. This 
command is used to specify the remote license server computer’s host name. 

Example: 

LICENSE_SERVER_EXISTS_REMOTE=1 
LICENSE_SERVER_EXISTS_REMOTE_HOSTNAME=LicenseServer 

 
LICENSE_SERVER_EXISTS_LOCAL=value 

Use a value of 1 to use an existing license server on this computer. A value of 0 indicates 
that this option is not to be used. If the option is not specified, it defaults to 0. 
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ToolMan Shortcut Locations 

Use to specify where you would like to create ToolMan icons/shortcuts 

USER_INPUT_DESKTOP_FLAG=value 
Use to put a ToolMan icon on the Desktop. A value of 0 does not put a ToolMan icon on 
the Desktop. A value of 1 puts a ToolMan icon on the Desktop. If the option is not 
specified, it defaults to 0. 
 
USER_INPUT_QUICK_LAUNCH_FLAG=value 
Use to put a ToolMan icon in the Quick Launch Bar. A value of 0 does not put a ToolMan 
icon in the Quick Launch Bar. A value of 1 puts a ToolMan icon in the Quick Launch Bar. 
If the option is not specified, it defaults to 0. 
 
USER_INPUT_PROGRAM_GROUP_FLAG=value 
Use to put a ToolMan shortcut in a Program Group. A value of 0 does not put a ToolMan 
shortcut in a Program Group. A value of 1 puts a ToolMan shortcut in a Program Group. 
If the option is not specified, it defaults to 0. This command is used with the 
USER_INPUT_PROGRAM_GROUP_NAME command described below. 
 
USER_INPUT_PROGRAM_GROUP_NAME=program group name 
Use to specify the name of the Program Group that you want a VERICUT Reviewer 
shortcut put in. This command is used with the USER_INPUT_PROGRAM_GROUP_FLAG 
command described above. 
 
USER_INPUT_ALL_USERS_FLAG=value 

Use to specify that specified icons/shortcuts are to be added for all users of this 
computer. 

Examples: 

The following command puts a VERICUT Reviewer icon the desktop. 

USER_INPUT_DESKTOP_FLAG=1 
 
The following pair of commands puts a VERICUT Reviewer shortcut in “CGTech VERICUT 
Reviewer 9.3.2” program group. 

USER_INPUT_PROGRAM_GROUP_FLAG=1 
USER_INPUT_PROGRAM_GROUP_NAME = CGTech ToolMan 9.3.2 
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VERICUT Interfaces 

SPATIAL_INSTALL=value 
Used to specify if the Spatial software used for the Model Interface option gets installed. 
A value of 0 does not install the Spatial software. A value of 1 installs the Spatial 
software. If the option is not specified, it defaults to 0.  
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Redundant License Server Setup 
If you plan to configure redundant license servers you should have identified the three 
(3) required license server computers, provided their Host ID's to CGTech, and received 
a license email containing the special license keys for redundant license servers. You 
should also have specified the three license servers (in the order, 
leader:follower1:follower2) during the VERICUT installation. 

A redundant license server configuration requires a special license configured for three 
(3) license servers. Earlier installation instructions explained how to request the license. 
Redundant license server configuration should only be done by experienced system 
administrators with networking experience. 

NOTE:  Each redundant server must have a static IP address. Dynamic IP addresses cause 
poor performance or failure. 

 

Follow the steps below to setup a Windows redundant license server configuration. 
These steps must be done by an "Administrator" user. The steps assume you have 
received the license email from CGTech. 

1. Save License File from License Email. 

(requires privileges to write to the VERICUT installation folders) 

 
Select Start > All Programs > CGTech license Server > License Server Only > Save 

License File from License Email.  
When the Create VERICUT License File screen displays, drag and drop the 

VERICUT license email from Microsoft Outlook, or Outlook Express, into the 
Create VERICUT License File screen. If you use another email program or 
cannot access the license email from the license server computer, save the 
license email as a "Text Only" or plain text file, then drag and drop the saved 
file into the Create VERICUT License File screen. You can also Copy/Paste the 
email contents into the Create VERICUT License File screen.  

The Create VERICUT License File screen's text area displays all the added license 
keys, followed by the message: 

"License file C:\cgtech932\windows\license\cgtech.lf created successfully".  
Close the Create VERICUT License File screen after the license file has been 

created.  
   
2. Determine the IP address of each of the 3 license servers. 

These will be used in the redundant license file configuration in the following steps. 
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3. Use WRlfTool.exe (eg. C:\Program Files\CGTech\License Server folder of your 
VERICUT installation) to create the redundant license file. 

 
Run …\windows\license\WrlfTool.exe. 
In the WRlfTool panel select File -> New. 
Press the Add Server button (in the upper half of the window).  
In Add Server to Pool panel, enter the Hostname and IP Address (or IPX Address) 

for the "leader" license server computer, and then press OK. 
Press the Add Server button two more times to add the Host Names and IP 

addresses for each of the two "follower" license server computers. All three 
redundant server host names and IP addresses should now appear in the 
Redundant Servers list. 

Press the Add License button (in the lower half of the window). 
In the Add Redundant License panel, select "Read License(s) from file". 
Press Browse and navigate to, and select, the cgtech.lf file you saved in step 1C 

above. Press Open, and then press OK. 
The Edit License panel opens, showing the first VERICUT license key in the 

License Code field on the right side of the panel, and the number of available 
licenses displayed in the Number of Tokens field (lower left in the panel). 

On the right side of the panel the 3 license server host names appear in the 
Server column. Check the Include checkboxes for all 3. 

Enter the value from Number of Tokens (lower left) in the Num Tokens column 
to the right of the first or "leader" server. This assigns all tokens for the 
displayed license key to the leader license server. Make sure that the Num 
Tokens values, for the two "follower" servers, is set to zero. 

Select Next License >> at the bottom of the panel to display the information for 
the next VERICUT feature. Repeat the previous step to assign all tokens for 
this license key to the leader license server. 

Repeat for each license key.  
Press Done at the bottom of the panel after the last license key is completed. 
Select File->Save As and save the redundant license file as "cgtech.lf" in the 

C:\Program Files\CGTech\License Server folder of the leader license server's 
VERICUT installation. 

4. Copy the redundant license to the other license servers. 

Copy the file cgtech.lf into the Program Files\CGTech\License Server of the VERICUT 
installation on each of the other two license server computers. 

 

5. Start the License Servers. 

CGTech strongly recommends you configure the license server program to 
automatically start when you start your computer. 
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NOTES:  
1. The license server computer requires TCP/IP network protocol installed on the 

network adaptor. See the section, Check Windows Network Configuration for 
more information. 

2. The following steps must be done by an Administrator user. 

3. If you are installing on a computer running Windows 10 Pro you will need to do 
the following before continuing with the Configure License & Setup Server steps. 

• Go to Control Panel > User Accounts > Change User Account Control 
settings (aka UAC). 

• Change it from  Default  to Never notify 

The Never Notify setting is to be used when using a program not certified for 
Windows 10 because it does not support User Account Control (like Sentinel 
or VERICUT). 

 

6. On the "leader" license server computer: 

Select Start > All Programs > CGTech License Server > License Server Only > Start 
License Server Service. This will automatically remove any existing service and add 
and start the service from the current folder. 

A. Select Start > All Programs > CGTech License Server > License Server Only > Set 
License File Environment Variable. 

B. Modify the system environment variable LSERVOPTS created in the previous 
step.  

C. The following is one way to do it: 
a. Find the "My Computer" icon, right-mouse click on it, and select 

Properties. 
b. In the System Properties panel, select the Advanced tab. Press the 

Environment Variables button located near the bottom of the panel. 
c. In the Environment Variables panel, scroll the lower System Variables 

list, select LSERVOPTS, and press the Edit button. 
d. In the Edit System Variable panel change the Variable Value by replacing 

the "-s" with "-rlf" 
e. Press OK in the Edit System Variable panel, and all remaining panels. 

D. Restart the computer. 
E. Repeats steps A through D for the two follower computers. 
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NOTES: 
1. Be sure to start the 3 redundant license server computers in the same order 

specified when the redundant license file was created. Starting them out-of-
order could cause problems designating the “leader” computer and assigning 
tokens. You should wait 1 or 2 minutes between starting each license server 
computer to make sure that it is fully started and ready to communicate with 
the next one. There is no "maximum" time limit between starting the license 
server computers. 

 
2. When starting a redundant license server, the error message "lservrc not 

found" may display. This message can be ignored. 
 

7. Verify the license servers started. 

All 3 redundant license servers should now be running and should be configured 
to automatically start. You can confirm that the server program is running using 
the Sentinel License Administrator program. 

Select Start > All Programs > CGTech License Server > License Utilities>  Sentinel 
License Administrator (WlmAdmin). You should see all 3 license server 
computers' host names appear under the Defined Servers list under the 'tree' 
displayed on the left side of the window. 

If they do not display you may need to add them using Edit > Defined Server List 
in the WlmAdmin panel. In a few seconds your VERICUT licenses should appear 
under the server computer's name (you may have to expand it). 

The redundant license server computers are now configured to automatically 
start the license server program, the VERICUT license keys exist in C:\Program 
Files\CGTech\License Server\cgtech.lf, and the license server programs are 
configured to read VERICUT license keys from the file. 

NOTE:  During VERICUT installation you should have specified the 3 license 
servers when prompted for the license server name. If you did not enter the 
three license server host names during installation, you can modify the name by 
selecting Start > All Programs > CGTech VERICUT x.x > License Administration > 
Specify License Server Computer. When the Notepad editor opens, change the 
line "set LSHOST=..." to be: 

set LSHOST=hostname1:hostname2:hostname3  

Where "hostname1", etc. are the names of your 3 redundant license servers. The 
names MUST be specified in the same order used when the redundant license 
file was created. The three hostnames are separated by colons ( : ). 
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8. Save the file and exit Notepad. 
 
NOTE:  For more detailed information about setting up a redundant license server 
configuration, see the Sentinel RMS License Manager System Administrator's Guide. 

 

If errors occur, visit the VERICUT Users' Forum or contact CGTech technical support via 
our website, just click on the support link.

https://docs.sentinel.thalesgroup.com/softwareandservices/rms/RMSDocumentation/SysAdmin/Content/Welcome.htm
http://cgtech.com/forum/
http://cgtech.com/
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Detailed VERICUT Configuration Tasks 

Windows Start Menu License Administration Choices 
 

The following describe the different Windows "Start Menu" choices under Start > All 
Programs > CGTech VERICUT 9.3.2 > License Administration. Some of these choices 
only display information and some require a Windows administrative user in order to 
make changes to system settings. 

  

License Utilities 
"License Utilities" choices are intended to help setup licensing or diagnose license 
problems on either the license server computer or the VERICUT client computer. 

  

Display Local License Servers 

View all Sentinel RMS license servers on this subnet. This choice uses the Sentinel 
RMS lswhere utility to display all Sentinel RMS license servers that can be 
communicated with. It uses Sentinel RMS's 'broadcast' feature to contact and collect 
information about various Sentinel RMS license servers on the same subnet as the 
current computer. It reports on any Sentinel RMS license servers, which may or may 
not have VERICUT licenses. For more information about advanced license server 
configuration options, see the  

 

Sentinel - Sentinel RMS License Manager System Administrator's Guide. 

  

Display Network Information 

Check IP and Ethernet addresses of network devices on this computer. This choice 
uses the Windows' command IPCONFIG /ALL to display important network 
information, especially TCP/IP configuration information. This can be used to 
determine if the TCP/IP configuration is valid (i.e. displays a valid IP address of the 
current computer). It also shows if multiple network devices are present, and their 
status. 

  

Sentinel RMS License Administrator (WlmAdmin) 
View licenses and status of running Sentinel RMS license servers using the Sentinel RMS 
Windows’ license utility WlmAdmin. WlmAdmin is configured with the VERICUT license 

https://docs.sentinel.thalesgroup.com/softwareandservices/rms/RMSDocumentation/SysAdmin/Content/Welcome.htm
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server identified during installation as a "Defined Server" in WlmAdmin's defined server 
list. For more information about the WlmAdmin utility see the Sentinel RMS License 
Manager System Administrator's Guide. 

 

 

Specify License Server Computer 

(requires privileges to write to the VERICUT installation folders) 

Direct VERICUT to get its licenses from a different license server computer. The choice 
opens the VERICUT configuration file, cgtenv.bat in Windows' Notepad text editor. 
Comments in the file identify the LSHOST environment variable and how to change it to 
specify a different VERICUT license server computer's host name. For more information 
about the LSHOST environment variable see the 
 

Sentinel RMS License Manager System Administrator's Guide. 

  

 

License Server Only 
"License Server Only" choices are only intended to be used on the license server 
computer, to help setup licensing or diagnose license problems. 

Configure License & Setup Server 

NOTES:  

1. Requires administrative privileges 
2. If you are installing on a computer running Windows 10 Pro you will need to 

do the following before continuing with the Configure License & Setup 
Server steps. 

• Go to Control Panel > User Accounts > Change User Account 
Control settings (aka UAC). 

• Change it from  Default  to Never notify 

The Never Notify setting is to be used when using a program not 
certified for Windows 10 because it does not support User Account 
Control (like Sentinel or VERICUT). 

This is typically the only selection used when setting-up a Windows license 
server. It does the following: 

1. Opens the Create License program and instructs the administrator to drag/drop the 
VERICUT license email into the screen. This creates the 'cgtech.lf' license file in the 
license folder. 

https://docs.sentinel.thalesgroup.com/softwareandservices/rms/RMSDocumentation/SysAdmin/Content/Welcome.htm
https://docs.sentinel.thalesgroup.com/softwareandservices/rms/RMSDocumentation/SysAdmin/Content/Welcome.htm
https://docs.sentinel.thalesgroup.com/softwareandservices/rms/RMSDocumentation/SysAdmin/Content/Welcome.htm
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2. Sets the system environment variable LSERVOPTS to point to the license file just 
created. 

3. Removes any previous Sentinel RMS license server service, then adds and starts the 
license server service from the current installation folder. When the server starts (via 
the service) it looks for the license file defined in LSERVOPTS, and adds the license 
keys. 
Display Host ID     

Display the Ethernet address of all enabled network adapters on this computer. The 
user selects one of these displayed Ethernet addresses as the HOST ID used to lock 
the license server to this computer. The program that displays the Ethernet 
addresses uses the exact same logic as the license server program. When a license is 
added to the license server program, it is compared against enabled network 
adapters. If the network adaptor encrypted in the license key does not match any of 
the enabled network adaptors, the key is not added to the license server. 

  

Remove License Server Service 

(requires administrative privileges) 

Stops the license server and removes the license server service on this computer. 
You can use Start License Server Service to restart a license server that is installed as 
a service. 

  

Run Temporary License Server 

(requires administrative privileges) 

Starts a temporary license server from the current user's login. You may use this 
choice to temporarily start the license server program, such as for testing or if it is 
not possible to add a service. The license server is temporary because it is 
terminated when the user logs-out of the current session. Use Configure License & 
Setup Server for a permanent installation of the server via Windows Services. 

  

Save License File from License Email 

(requires privileges to write to the VERICUT installation folders) 

Creates the VERICUT license file from a license email or text file containing the 
license keys. This choice opens a utility program that reads the license keys in the 
CGTech license email and creates the cgtech.lf license file in the local installation's 
'license' folder. The utility program reads the license email via: 

1. Drag/drop the email directly from Microsoft Outlook or Outlook Express. 

2. Drag/drop a saved email message file (.msg or .eml). 
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3. Copy/paste the email's text. For example you can select all the text (typically 
Edit > Select All in your email program), then paste it into the Create License 
panel with the right-mouse menu > Paste menu button. 

4. Drag/drop a plain text file saved from the license email. 

   

The Create License panel's text area displays all the added license keys, followed by 
the message "License file C:\Program Files\CGTech\License Server \cgtech.lf 
created successfully". The license server program reads the cgtech.lf license file 
when it starts, and adds valid license keys to the running license server. 

  

Set License File Environment Variable 

NOTES:  

1. Requires administrative privileges 
2. If you are installing on a Windows 10 Pro computer you will need to do the 

following before continuing with the Configure License & Setup Server steps. 
• Go to Control Panel > User Accounts > Change User Account Control 

settings (aka UAC). 
• Change it from  Default  to Never notify 

The Never Notify setting is to be used when using a program not certified 
for Windows 10 because it does not support User Account Control (like 
Sentinel or VERICUT). 

Sets the LSERVOPTS system environment variable, used by the license server to find 
the cgtech.lf license file when the Windows service starts the license server. This 
setting is only used by the license server started as a Windows service. For more 
information about LSERVOPTS and its options see the 

Sentinel RMS License Manager System Administrator's Guide. 

 

 NOTE:  A restart is required after the environment variable is changed. 
 

Start License Server Service 

(requires administrative privileges) 

Stops and removes any existing license server service, then installs and starts the 
license server service from the current installation. This choice is only effective when 
using a license server service. 
  
Stop License Server Service 

(requires administrative privileges) 

https://docs.sentinel.thalesgroup.com/softwareandservices/rms/RMSDocumentation/SysAdmin/Content/Welcome.htm
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Stops a running license server service on this computer. The service is not removed, 
only stopped. 
  
 Update Licenses on Running Server  

(requires administrative privileges if used on a license server service) 

Causes the running license server to re-read the license file. The server must be 
running when this selection is used. This selection uses the Sentinel RMS lslic 
program to remove the current licenses, then re-reads the license keys in the 
cgtech.lf license file and adds them to the running license server. For more 
information about the lslic program see the Sentinel RMS License Manager System 
Administrator's Guide. 

Return to “Other Configuration Tasks” 

 

  

https://docs.sentinel.thalesgroup.com/softwareandservices/rms/RMSDocumentation/SysAdmin/Content/Welcome.htm
https://docs.sentinel.thalesgroup.com/softwareandservices/rms/RMSDocumentation/SysAdmin/Content/Welcome.htm
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Alternate Method to Determine Your Windows License 
Server Computer’s HOST ID 
 

If you do not have access to the VERICUT DVD you can display the HOST ID as follows: 

• Open a Command Prompt window (also called a DOS window) 

• Type in the window: Ipconfig  /all 

The value shown to the right of "Physical Address" is typically the HOST ID. Valid IDs are 
12 characters and contain only the characters 0-9 and A-F. If your computer has multiple 
network adapters, the license server program compares the address encrypted in the 
license keys with enabled network adapters. If a network adapter address matching the 
encrypted key address is found then the license is added to the server. 

The following Physical Addresses are not valid, and indicate something is wrong with the 
TCP/IP network protocol configuration for the Ethernet device, or indicates the card is 
not enabled or available: 

000000000000 

204c4f4f5020 

ffffffff 

ffffffffffff 

NOTE:  The license server delivered with this version of VERICUT only requires the 
device to be enabled. It no longer requires it to be connected or have an active 
network transport such as IPX/SPX.  

 

See the section on Check Windows Network Configuration if you are having trouble 
getting a valid Physical Address. 

 

Return to “Other Configuration Tasks” 
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Check Windows Network Configuration    
 

In any VERICUT installation there is a computer that functions as the license server 
computer. There are also one or more client computers that run VERICUT and 
communicate with the license server computer to get licenses. In a stand-alone 
configuration the license server computer and the VERICUT client computer are one-in-
the-same, but the same network communication requirements apply. The following 
checks ensure that the license server computer and the VERICUT client computer(s) can 
communicate, and that the VERICUT client computers can successfully run VERICUT. 

 
Checks for both the License Server Computer and VERICUT Client 
Computers 
 
1. Check the network hardware. 

Ensure that you have a network adapter installed and enabled on the license server 
computer. You can use the Windows Device Manager (available under the Control 
Panel's System icon) to see if you have an installed network adapter. The VERICUT 
license keys are encrypted to match the physical address of an enabled network 
adapter. When the license server program initially starts it finds enabled network 
adapters and compares each license key with the physical address of the adapter(s). 
If a match is found the license key is added to the license server. 

 
2. Check the network software. 

VERICUT and the license server program use TCP/IP network protocol to 
communicate with each other, even when running VERICUT on a single stand-alone 
computer (where both VERICUT and the license server program run on the same 
computer). TCP/IP network protocol must be installed on the enabled network 
adapter that matches the Host ID encrypted in your VERICUT license. 

If you need to add TCP/IP protocol and your computer is on a company network you 
should consult with your network administrator. If you are on a computer with no 
network connection and you need help on how to add TCP/IP protocol, see the 
section, Basic Windows Network Configurations. 
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Checks for the License Server Computer 
 
1. Serving licenses to other client computers. 

In addition to having a network adapter and TCP/IP network protocol installed, the 
license server computer must have a valid IP address in order to serve licenses to 
other computers. A static IP address should be used. If a dynamic IP address is 
assigned using a DHCP server, then VERICUT license check-out on client computers 
may be slow and/or inconsistent. Static IP addresses are required for all license 
server computers in a redundant server configuration. 

Use the ipconfig command to verify there is an enabled network adapter with 
TCP/IP protocol installed and that it is properly configured to be the license server 
computer. Type the following command in a command prompt window (also called 
a 'DOS' window): 

ipconfig /all 

 

The ipconfig command returns information about your computer's network 
configuration. Only a few items are important for your VERICUT installation. If your 
computer is connected to a network and TCP/IP protocol is installed and configured 
correctly, the following lines should have values in order for the license server 
program to provide licenses to VERICUT on another computer: 

        Host Name . . . . . . . . . . . .   : mycomputer 

        Physical Address. . . . . . . . .  : 00-0B-AB-77-34-64 

        IP Address. . . . . . . . . . . .   : 199.1.1.123 

        Subnet Mask . . . . . . . . . . .   : 255.255.255.0 

 
2. No network connection, stand-alone configuration. 

If your computer is not connected to a network, or your computer is sometimes 
disconnected from a network when you want to use VERICUT (thus it is a stand-
alone configuration with VERICUT and the license server program running on the 
same computer), then at a minimum you must have an enabled network adaptor. 

When disconnected from a network, ipconfig may not display an IP address. This 
does not cause a problem for VERICUT or the license server program because the IP 
loopback address (127.0.0.1) is used automatically. A Host Name is required, but the 
default name, "localhost" is sufficient. 

The following values should be displayed by ipconfig for a stand-alone configuration:  

        Host Name . . . . . . . . . . . .   : mycomputer (or localhost) 

        Physical Address. . . . . . . . .  : 00-0B-AB-77-34-64 
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Checks for VERICUT Client Computers 
 
1. Set the optimum color display for VERICUT 

True or high color display provides optimum VERICUT performance. Desktop color 
display is changed by opening the Display icon in the Control Panel, or by right-click 
> Properties on the desktop. 

NOTE:  The following checks are not necessary for a stand-alone configuration where 
VERICUT and the license server program run on the same computer. 

 
2. Check the VERICUT client computer's network software configuration. 

In addition to having a network device and TCP/IP network protocol installed, the 
device must have a valid IP address (either statically assigned, automatically created, 
or dynamically provided by a DHCP server). 

Use the ipconfig command to verify that there is an active network device with the 
TCP/IP protocol installed and that it is properly configured with a host name and IP 
address. Open a command prompt window (also called a 'DOS' window) and type: 

ipconfig /all 

 

The ipconfig command returns information about your computer's network 
configuration. Only a few items are important for your VERICUT installation. If your 
computer is connected to a network, and TCP/IP protocol is installed and configured 
correctly, the following lines must have values in order for VERICUT to work 
correctly: 

 Host Name . . . . . . . . . . . .   : mycomputer 

 Physical Address. . . . . . . . .  : 00-0B-AB-77-34-64 

 IP Address. . . . . . . . . . . .   : 199.1.1.123 

 Subnet Mask . . . . . . . . . . .   : 255.255.255.0 

 

3. Verify client and license server computers can communicate with each other. 

Both client and license server computers must have host names and valid IP 
addresses. The mechanism for assigning host names and IP addresses varies with the 
network configuration. See your site's network administrator if you are not familiar 
with how your network is configured. 

The easiest way to verify communication between computers is to "ping" each one 
from the other.  Open a command prompt window and type: 

ping COMPUTER1 
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(where 'COMPUTER1' is the host name of the computer you need to 
communicate with) 

 

If the computers can communicate you should see something like: 

Pinging COMPUTER1 [199.1.1.123] with 32 bytes of data: 

  

Reply from 199.1.1.123: bytes=32 time=48ms TTL=127 

Reply from 199.1.1.123: bytes=32 time=46ms TTL=127 

Reply from 199.1.1.123: bytes=32 time=43ms TTL=127 

Reply from 199.1.1.123: bytes=32 time=41ms TTL=127 

  

Ping statistics for 199.1.1.123: 

    Packets: Sent = 4, Received = 4, Lost = 0 (0% loss), 

Approximate round trip times in milli-seconds: 

    Minimum = 41ms, Maximum = 48ms, Average = 44ms 

 

You should ping the client from the license server computer and the license server 
computer from the client since both computers must know about each other for 
proper communication. If the ping test fails contact your site's network 
administrator to correct the problem. 

In some network configurations there may be a router, gateway or other network 
device that acts like a firewall between the client and license server computer. In this 
case, the ping test will succeed but licensing will fail since the router or firewall must be 
configured to allow TCP/IP to pass UDP packets through port 5093. For this and other 
complex network configurations contact your site's network administrator and see the 
Sentinel RMS License Manager System Administrator's Guide., for more information 
about configuring the Sentinel RMS license server and clients 

 

Return to “Other Configuration Tasks” 

 

 

  

https://docs.sentinel.thalesgroup.com/softwareandservices/rms/RMSDocumentation/SysAdmin/Content/Welcome.htm
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Basic Windows Network Configurations 
 

Use the appropriate section below to properly configure your network device for 
VERICUT on Windows computers. 

 
To check for network software on Windows XP Professional: 
When using the Start Menu, 

1. Taskbar: Start > Control Panel > Network Connections 
2. Double click on the Device icon. 
3. Select Support tab. 

Installed software must include "Internet Protocol TCP/IP". 

 

When using "classic" Start Menu, 

1. Taskbar: Start > Settings > Network Connections 
2. Double click on the Device icon. 
3. Select Support tab 

Installed software must include "Internet Protocol TCP/IP". 
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Configuring VERICUT to Read an NX Part File 
 
 
An NX part file can be opened directly in VERICUT. The following describe the 
environment variables that need to be set. 
 

The following environment variables need to be set in VERICUT's environment: 

UGII_BASE_DIR 

UGII_BASE_DIR is setup by an NX installation in the system environment space 
and typically points to the place where NX is installed, for example C:/Program 
Files/UGS/NX 6.0/. 

UGII_ROOT_DIR 

UGII_ROOT_DIR is setup by an NX installation in the system environment space 
and typically points to the location of the NX executable files, for example 
C:/Program Files/UGS/NX 6.0/UGII/. 

Also, UGII_ROOT_DIR must be set in the execution path (the "path" environment 
variable). 

  
Additional requirements: 
 

1. NX6, NX7, NX7.5, NX8, NX8.5 or NX9 must be installed on the computer that is 
running VERICUT. 

2. An NX license must be available. 

 
 

Return to “Other Configuration Tasks” 
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Uninstall VERICUT 
 

Uninstalling is recommended when a VERICUT software version is no longer needed, or 
when disk space is limited. Use the appropriate procedure below to remove a version of 
VERICUT software from your computer. 

 

To remove VERICUT software from a Windows computer: 
1. Remove the license server service by selecting Start > All Programs > CGTech 

License Server > License Server Only > Remove License Server Service. Do this 
BEFORE uninstalling! 

2. Unistall VERICUT by selecting Start > Programs > CGTech VERICUT x.x > Utilities 
>Uninstall VERICUT x.x (where "x.x" is the version of VERICUT to be uninstalled) 
and follow the prompts of the "uninstall" program. You can also start the 
"uninstall" program using the UninstallVERICUT.exe, located in the 
UninstallerData folder of your VERICUT software installation. 

 

 

NOTE:  There may be program folder/files that are not removed by uninstalling. These 
were created after VERICUT was installed and will have to be removed manually. 

 

During the uninstall process the following dialog may appear. You do not have to do a 
system restart and may just press the “continue” button to proceed. 

 

 
 

  



Installing CGTech Products 

62 

Other VERICUT Configuration Tasks    
Following are configuration tasks that may need to be done depending on the CGTech 
products you are using. 

• To configure CAD/CAM Interface modules, go to one of the following:  

CATIA V5-to-VERICUT Interface for CATIA version 5 

CATIAV6-to-Vericut Interface for CATIA/DELMIA V6 

CATIA V5-to-VERICUT Drilling and Fastening Interface (CAT2VDAF) 

CAMWorks to VERICUT Interface 

EdgeCAM-to-VERICUT Interface 

ESPRIT-to-VERICUT Interface 

GibbsCam-to-VERICUT Interface (GibbsV) 

Mastercam-to-VERICUT Interface (MCAMV)  

NX-to-VERICUT Interface (NXV) 

NX-to-VERICUT Drilling and Fastening Interface (NX2VDAF) 

Pro/E-to-VERICUT Interface (PROEV)  

SURFCAM to VERICUT Interface 

 

• To install the CAD Model Interface modules, go to Installing the Model Interface 
Modules. 

• To enable VERICUT to read NX files directly, go to Configuring VERICUT to Read 
an NX Part File 

• To configure the VERICUT TDM Interface, go to VERICUT TDM Systems Interface. 

 

Following are other configuration tasks that may need to be done, depending on your 
site's requirements. 

• Windows Start Menu License Administration Choices 

• Determine Your License Server's Host ID 

• Check Network Configuration 

• Change License Servers 

• Update an Existing License 

• Stop and Remove a License Server  

• Starting a Temporary License Server  
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• Download and Install the Latest Point Release for Windows 

• Installing Microsoft C++ redistributable run-time libraries for XP64 

• Configure Redundant License Servers on Windows  

 

Move Windows License Server 
 

It is sometimes desirable (or necessary), due to hardware upgrades or network changes, 
to move your VERICUT license server to a different license server computer. To move 
the license server in an existing installation, do the following: 

1. Request a license for the new license server computer using CGTech's on-line 
license Transfer Request form.  

(Once you receive the license email containing your new license keys, continue 
with the following steps.) 

2. Stop and Remove the Windows License Server. 

3. Follow the VERICUT Installation Steps to install VERICUT on the new license 
server computer. 

4. Modify VERICUT client computer installations to use the newly installed license 
server computer. 

Do step 4 for each VERICUT or VERICUT Composite Software installation in your 
network. 

 

Return to “Other Configuration Tasks” 

 

 

  

http://www.cgtech.com/vericut_support/request-license/transfer-request/
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Modify VERICUT on Windows to Use a Different License 
Server Computer    
To change an existing VERICUT Windows installation to access VERICUT licenses on a 
different license server computer: 

1. Select Start > All Programs > CGTech VERICUT 9.3.2 > Utilities > Specify License 
Server Computer (opens the file in Notepad) 

2. Change the line: 

set LHOST=server1 

3. Replace "server1" (or the name of your old license server computer) with the 
host name of the new license server computer. 

4. Save the file cgtenv.bat. 
 

Return to “Other Configuration Tasks” 
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Update a License on Windows License Server 
These instructions assume you have received a new license from CGTech via email. If 
you have not, and you need to request a new license, see Determine the HOST ID and 
Request a License. To update your VERICUT license on a Windows license server, do the 
following (on the license server computer): 

4. Create the license file from the license email or saved text file. 
 

A. Select Start > All Programs > CGTech License Server > License Server Only > Save 
License File from License Email. 

B. Drag and drop the VERICUT license email from Microsoft Outlook, or Outlook 
Express, into the Create License File panel. If you use another email program, or 
cannot access the license email from the license server computer, then save the 
license email as a "Text Only" or plain text file and drag/drop the saved file into 
the Create License File panel. 

C. Close the Create License File panel after the "success" message displays. 

 
5. Update the licenses on the running license server. 

Select Start > All Programs >  CGTech License Server > License Server Only > Update 
Licenses on Running Server. Do not attempt to do this action unless you know your 
license server is running. If you are not sure, you can verify that the server is running 
using Start > All Programs CGTech License Server > License Utilities > Display Local 
License Servers. Your server's Host Name should appear in the resulting panel. 

 

If errors occur, visit the VERICUT Users’ Forum or contact CGTech technical support via 
our website, just click on the support link. 

 

 

Return to “Other Configuration Tasks” 

  

http://www.cgtech.com/vericut_support/request-license/
http://cgtech.com/forum/
http://cgtech.com/
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Stop and Remove a Windows License Server  
Only one license server can run on the license server computer. The license server from 
the newest installed version should be used. The old license server should be stopped 
and removed before configuring and starting the new license server. 

 

Stop and remove a Windows license server service 

NOTE:   The following must be done by an Administrator user. 

Start > All Programs > CGTech License Server > License Server Only > Remove License 
Server Service 

 

Stop and remove a temporary license server process 

Right-mouse click on the SentinelLM task in the windows task bar, and choose Close. 

Remove any mechanism which might have been configured to automatically start 
the temporary server. For example, you may need to remove a shortcut to the 
temporary server startup batch file from the Start > All Programs > Startup folder. 

 

If errors occur, visit the VERICUT Users' Forum or contact CGTech technical support via 
our website, just click on the support link. 

 

Return to “Other Configuration Tasks” 

 
  

http://cgtech.com/forum/
http://cgtech.com/
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Starting a Temporary Windows License Server 
  

The following describes how to start a temporary license server. But, it is strongly 
recommended that you configure the license server program to automatically start 
using Windows services. If for some reason you cannot configure the license server 
service, then it can be temporarily started.  

To start a temporary license server select: 

Start > All Programs > CGTech License Server > License Server Only > Run 
Temporary License Server.  

You could add a Windows shortcut to your desktop to make access to this procedure 
easier.  

This Start menu item could also be added to the Windows Startup folder so that it 
automatically starts when you log-in. 

 

NOTES: 

1. A temporary license server can only be started by an Administrator user. 
2. The temporary license server process is owned by the specific user that starts it. 

When that user logs-out, the license server program terminates. 
3. Starting a temporary license server stops the Windows license server service if it 

is running. 

 

If errors occur, visit the VERICUT Users' Forum or contact CGTech technical support via 
our website, just click on the support link. 

 

 

Return to “Other Configuration Tasks” 

 
  

http://cgtech.com/forum/
http://cgtech.com/
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Download and Install the Latest Point Release for 
Windows 
 

VERICUT point releases for Windows are available on the CGTech web site. The 
following steps will guide you through downloading and installing a VERICUT point 
release (we'll use 9.3.2 as an example below):  

Download Instructions:                                                         

The VERICUT 9.3.2 Windows version (Windows 10, 64 bit) is available for 
download from our web site. Follow this link to open the on-line form to begin the 
download process: 

http://www.cgtech.com/vericut_support/request-software-update/ 

To download the file, you will need your Company ID and the access code from the 
"VERICUT 9.3.2 is available for download" email that was sent to all customers on 
maintenance. If you are not currently on maintenance, contact your CGTech 
representative.  

 

Starting the Installation: 

After downloading the zipped installer, unzip it to a temporary folder. The zip file is 
password protected. The password was also included in the "VERICUT 9.3.2 is 
available for download" email. 

Once the files are unzipped, double-click on install.exe to begin the installation. 

 

Return to “Other Configuration Tasks” 

XP 

 

  

http://www.cgtech.com/vericut_support/request-software-update/
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Install Microsoft redistributable C++ Run-Time Libraries 
 

VERICUT on Win7 64 may require installation of the correct version of Microsoft’s C++ 
run-time libraries. The following describes the 64 bit version of the libraries. 

  

Get the vcredist_x64.exe installer: 

The redistributable C++ run-time is available:             

In the VERICUT installation in: 

• C:\Program Files\cgtech\VERICUT 
\redist\\windows64\spatial\redist\VC15\vcredist_x64.exe 

OR 

• C:\Program Files\cgtech\VERICUT 
\redist\\windows64\windows64\spatial\iop2021\redist\VC15\vcredist_x64.exe 

where “C:\Program Files\cgtech\VERICUT \” is your installation location. 

OR 

Download from ’s download site at:   

http://www.cgtech.com/vericut_support/system-requirements 

 

You may also need Microsoft Redistributable Install DSS Software Installer, available at: 

• C:\Program Files\CGTech\VERICUT 
9.3.X\windows64\spatial\redist\InstallDSSoftwareVC11Prerequisites_x86_x64.m
si 

OR 

• https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-
c-downloads  

 

Installation: 

Double-click on the installer to install. There are no prompts during installation 
and no confirmation of completion. You must have Administrator privileges to do 
the install. 

 

 

Return to “Other Configuration Tasks” 

http://www.cgtech.com/vericut_support/system-requirements
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads


Installing CGTech Products 

70 

 

 

Configuring CAD/CAM to VERICUT Interfaces 
Choose the interface you want to configure from the following: 

3DEXPERIENCE-to-VERICUT Interface (CATV6_3dx) 

3DEXPERIENCE-to-VERICUT Interface (CATV6_3dxml) 

CAMWorks-to-VERICUT Interface (CWV) 

CATIA V5-to-VERICUT Interface (CATV5) 

CATIA V5-to-VDAF Interface (CAT2VDAF) 

Creo Parametric-to-VERICUT Interface (PROEV) 

Edgecam-to-VERICUT Interface (ECV) 

ESPRIT-to-VERICUT Interface (ESV) 

GibbsCAM-to-VERICUT Interface (GibbsV) 

Mastercam-to-VERICUT Interface (McamV) 

PowerMill-to-VERICUT Interface (PMV) 

Siemens NX-to-VERICUT Interface (NXV) 

Siemens NX-to-VDAF Interface (NX2VDAF) 

SURFCAM-to-VERICUT Interface (SCV) 

NOTE: If using the interface with VERICUT Single Platform you’ll need to add an 
environment variable so that the interface will launch the correct version of VERICUT. 
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3DEXPERIENCE-to-VERICUT Interface (CATV6_3dx)  
VERICUT offers two 3DEXPERIENCE interfaces: CATV6_3dx and CATV6_3dxml.  
CATV6_3dx, the Interface reads all Fixture, Stock, Design and 3D tool representations 
form 3DEXPERIENCE manufacturing process.  
 

Prerequisites  
CATV6_3dx is a licensed software program that provides a 3DEXPERIENCE to VERICUT 
data transfer connection. The interface is an executable that is designed to work with 
3DEXPERIENCE.  
 
3DEXPERIENCE Versions supported:  
3DEXPERIENCE R2017x FP1918 (internal level 6.419.22.0) and later 
3DEXPERIENCE R2018x FD08 FP1912 (internal level 6.420.10.0) and later 
3DEXPERIENCE R2019x FD02 FP1914 (internal level 6.421.5.0) and later 
3DEXPERIENCE R2020x Hotfix 0.3 (Internal build level 6.422.0.0) and later 
3DEXPERIENCE R2021x Hotfix 0.6 (Internal build level 6.432.0.0) and later 
 

 
 

CGTech Licensing:  
CATIA V6 Interface 
Dassault Systems Licensing:  
NC Machine Code Validation Specialist (NMV) 
 
Minimum VERICUT Version required:  
VERICUT 7.2 
Minimum VERICUT License Version required:  
8.0 
Versions of 3DEXPERIENCE tested with CATV6_3dx: 
3DEXPERIENCE R2013x - R2021x 

 
 

 

Installation - Configuration 
For the 3DEXPERIENCE (CATV6_3dx) Interface, no user configuration is required. The 
interface installation files are located at C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\CATV6_3dx and can be accessed by C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\commands\catv6_3dx_version.bat  
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Environment variables 
To enable the 3DEXPERIENCE Interface to find the necessary VERICUT files, you also 
need to define three environment variables, CGTECH_INSTALL, CGTECH_PRODUCTS and 
LSHOST.  CGTECH_SINGLE_PLATFORM and CATV_LANGUAGE are optional.   

No. Environment Variable Example 

1 CGTECH_INSTALL C:\Program Files\CGTech\VERICUT x.x.x 
 

2 CGTECH_PRODUCTS C:\Program Files\CGTech\VERICUT 
x.x.x\windows64  
 

3 LSHOST localhost 
 

4 CGTECH_SINGLE_PLATFORM YES 
 

5 CATV_LANGUAGE C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\CATV6_3dx\CatvFrench.local  

 
CGTECH_INSTALL is set to the VERICUT installation folder. In the above table, x.x.x 
represents the VERICUT release number. For a typical VERICUT 9.3.2 installation this 
variable is set to C:\Program Files\CGTech\VERICUT 9.3.2\.  
Defining a value explicitly for the CGTECH_INSTALL environment variable is optional. It 
can be derived from the CGTECH_PRODUCTS environment variable value. 
 
CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: "windows64". In the above table, x.x.x represents the 
VERICUT release number. For a typical VERICUT 9.3.2 installation this variable is set to 
C:\Program Files\CGTech\VERICUT 9.3.2\windows64.  
 
LSHOST is set to the name of the license server computer.  
 
CGTECH_SINGLE_PLATFORM=YES If you are using VERICUT single Platform then an 
additional environment variable needs to be defined for the interface. 
CATV_LANGUAGE If you want the interface to use something other than US English, the 
variable can specify a file of localized text. Versions for French, German, Italian, 
Portuguese, Chinese, and Japanese are supplied.  
 
Use the Microsoft Windows Control Panel > System Properties > Advanced tab > 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information.  
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To add an icon to the Toolbar 
No configuration required  

 

Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries (Microsoft 
Redistributables). The Microsoft Redistributable vc_redist.x64.exe Installer is also 
available for download at: https://support.microsoft.com/en-ca/help/2977003/the-
latest-supported-visual-c-downloads 
 
 
 
 
 
 

3DEXPERIENCE-to-VERICUT Interface (CATV6_3dxml) 
VERICUT offers two 3DEXPERIENCE interfaces: CATV6_3dx and CATV6_3dxml.  
CATV6_3dxml reads all Fixture, Stock and Design models from the 3dxml file and some 
tool information.  
  

Prerequisites  
CATV6_3dxml is a licensed software program that provides a 3DEXPERIENCE to VERICUT 
data transfer connection. The interface is an executable that is designed to work with 
3DEXPERIENCE. 
 
 
3DEXPERIENCE Versions supported:  
3DEXPERIENCE 2017x (or later) 
 
 
CGTech Licensing:  
CATIA V6 Interface 
 
Minimum VERICUT Version required:  
VERICUT 7.2 
Minimum VERICUT License Version required:  
8.0 
Versions of 3DEXPERIENCE tested with CATV6_3dxml: 
3DEXPERIENCE R2013x - R2021x 

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Installation - Configuration 
For the 3DEXPERIENCE (CATV6_3dxml) Interface, no user configuration is required. The 
interface installation files are located at C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\CATV6_3dxml and can be accessed by C:\Program 
Files\CGTech\VERICUT x.x.x\windows64\commands\catv6_3dxml_version.bat  
 
 

Environment variables 
To enable the 3DEXPERIENCE Interface to find the necessary VERICUT files, you also 
need to define three environment variables, CGTECH_INSTALL, CGTECH_PRODUCTS and 
LSHOST.  CGTECH_SINGLE_PLATFORM and CATV_LANGUAGE are optional.   

No. Environment Variable Example 

1 CGTECH_INSTALL C:\Program Files\CGTech\VERICUT x.x.x 
 

2 CGTECH_PRODUCTS C:\Program Files\CGTech\VERICUT 
x.x.x\windows64  
 

3 LSHOST localhost 
 

4 CGTECH_SINGLE_PLATFORM YES 
 

5 CATV_LANGUAGE C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\CATV6_3dx\CatvFrench.local  

 
CGTECH_INSTALL is set to the VERICUT installation folder. In the above table, x.x.x 
represents the VERICUT release number. For a typical VERICUT 9.3.2 installation this 
variable is set to C:\Program Files\CGTech\VERICUT 9.3.2\.  
Defining a value explicitly for the CGTECH_INSTALL environment variable is optional. It 
can be derived from the CGTECH_PRODUCTS environment variable value. 
 
CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: "windows64". In the above table, x.x.x represents the 
VERICUT release number. For a typical VERICUT 9.3.2 installation this variable is set to 
C:\Program Files\CGTech\VERICUT 9.3.2\windows64.  
 
LSHOST is set to the name of the license server computer.  
 
CGTECH_SINGLE_PLATFORM=YES If you are using VERICUT single Platform then an 
additional environment variable needs to be defined for the interface. 
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CATV_LANGUAGE If you want the interface to use something other than US English, the 
variable can specify a file of localized text. Versions for French and German and 
Japanese are supplied.  
 
Use the Microsoft Windows Control Panel > System Properties > Advanced tab > 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information.  
 
 

To add an icon to the Toolbar 
No configuration required  
 
 

Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries (Microsoft 
Redistributables). The Microsoft Redistributable vc_redist.x64.exe Installer is also 
available for download at: https://support.microsoft.com/en-ca/help/2977003/the-
latest-supported-visual-c-downloads 
 
 
 
 
 
 

CAMWorks-to-VERICUT Interface (CWV) 

Prerequisites  
CWV is a licensed software program that provides a CAMWorks to VERICUT data 
transfer connection. The interface is a SolidWorks macro that is designed to work on top 
of CAMWorks, which already is an add-in working inside SolidWorks CAD software 
system.  
Although, the macro is called from SolidWorks, it will not be used if the CAMWorks add-
in is not loaded into SolidWorks.  
 
SolidWorks / CAMWorks Versions supported:  
SolidWorks 2017 (or later) / CAMWorks 2017 (or later) 
 
CGTech Licensing:  
Solidworks Interface 
 

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Minimum VERICUT Version required:  
VERICUT 7.2 
Minimum VERICUT License Version required:  
8.0 
Versions of SolidWorks/CAMWorks tested with CWV: 
SolidWorks 2016/CAMWorks 2016 – 2020/2020 
 

Installation - Configuration 
For the CAMWorks Interface, no user configuration is required. The interface installation 
files are located at C:\Program Files\CGTech\VERICUT x.x.x\windows64\camworks and 
can be accessed directly from SolidWorks. 
Note:  You will need to ensure that Enable VSTA VERSION 3.0 is checked 
Menus: SolidWorks > System Options > General > Enable VSTA VERSION 3.0 
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Environment variables 
To enable the CAMWorks Interface to find the necessary VERICUT files, you also need to 
define three environment variables, CGTECH_INSTALL, CGTECH_PRODUCTS and 
LSHOST.  CGTECH_SINGLE_PLATFORM is optional.   

No. Environment Variable Example 

1 CGTECH_INSTALL C:\Program Files\CGTech\VERICUT x.x.x 
 

2 CGTECH_PRODUCTS C:\Program Files\CGTech\VERICUT 
x.x.x\windows64  
 

3 LSHOST localhost 
 

4 CGTECH_SINGLE_PLATFORM YES 
 

 
CGTECH_INSTALL is set to the VERICUT installation folder. In the above table, x.x.x 
represents the VERICUT release number. For a typical VERICUT 9.3.2 installation this 
variable is set to C:\Program Files\CGTech\VERICUT 9.3.2.  
Defining a value explicitly for the CGTECH_INSTALL environment variable is optional. It 
can be derived from the CGTECH_PRODUCTS environment variable value. 
 
CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: "windows64". In the above table, x.x.x represents the 
VERICUT release number. For a typical VERICUT 9.3.2 installation this variable is set to 
C:\Program Files\CGTech\VERICUT 9.3.2\windows64.  
 
LSHOST is set to the name of the license server computer.  
 
CGTECH_SINGLE_PLATFORM=YES If you are using VERICUT single Platform then an 
additional environment variable needs to be defined for the interface. 
 
Use the Microsoft Windows Control Panel > System Properties > Advanced tab > 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information.  
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To add an icon to the Toolbar 
A shortcut button or icon can be added to the CAMWorks menu to access the 
‘VERICUT_Interface.dll’ as shown in the picture below. 
 
Steps to configure the icon:  

• From the SolidWorks toolbar, select the pull-down next to Options icon and 
select Customize…  

  

  
  

• Select Commands tab; Categories: Macro 

• Drag and drop New Macro Button  onto the CAMWorks Toolbar 
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• Specify the location of the VERICUT_Interface.dll  
• Method: enter main 

  

  
  
NOTE: For an Icon you can select C:\Program Files\CGTech\VERICUT 
9.3.2\windows64\solidworks\VERICUTAddin.bmp 
  

• Select OK 
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Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries (Microsoft 
Redistributables). The Microsoft Redistributable vc_redist.x64.exe Installer is also 
available for download at: https://support.microsoft.com/en-ca/help/2977003/the-
latest-supported-visual-c-downloads 
 
 
 
 

CATIA V5-to-VERICUT Interface (CATV5) 

Prerequisites  
CATV5 is a licensed software program that provides a CATIA V5 to VERICUT data transfer 
connection. The interface is an executable that is designed to work with CATIA V5.  
 
CATIA V5 Versions supported:  
CATIA V5 R18 (or later) 
 
CGTech Licensing:  
CATIA V5 Interface 
 
Minimum VERICUT Version required:  
VERICUT 8.0 
Minimum VERICUT License Version required:  
8.0 
Versions of CATIA V5 tested with CATV5: 
CATIA V5 (R18) - CATIA V5-6R2019 (R29) 
 
 
 

Installation - Configuration 
For the CATV5 Interface, no user configuration is required. The interface installation files 
are located at C:\Program Files\CGTech\VERICUT x.x.x\windows64\catv5 and can be 
accessed directly from CATIA V5 or C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\commands\catv5.bat  
  

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Environment variables 
To enable the CATIA V5 Interface to find the necessary VERICUT files, you also need to 
define three environment variables, CGTECH_INSTALL, CGTECH_PRODUCTS and 
LSHOST.  CGTECH_SINGLE_PLATFORM and CGTECH_CATV_LANGUAGE are optional.   

No. Environment Variable Example 

1 CGTECH_INSTALL C:\Program Files\CGTech\VERICUT x.x.x 
 

2 CGTECH_PRODUCTS C:\Program Files\CGTech\VERICUT 
x.x.x\windows64  
 

3 LSHOST localhost 
 

4 CGTECH_SINGLE_PLATFORM YES 
 

5 CGTECH_CATV_LANGUAGE C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\catv5\CATVFrench.local  

 
CGTECH_INSTALL is set to the VERICUT installation folder. In the above table, x.x.x 
represents the VERICUT release number. For a typical VERICUT 9.3.2 installation this 
variable is set to C:\Program Files\CGTech\VERICUT 9.3.2.  
Defining a value explicitly for the CGTECH_INSTALL environment variable is optional. It 
can be derived from the CGTECH_PRODUCTS environment variable value. 
 
CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: "windows64". In the above table, x.x.x represents the 
VERICUT release number. For a typical VERICUT 9.3.2 installation this variable is set to 
C:\Program Files\CGTech\VERICUT 9.3.2\windows64.  
 
LSHOST is set to the name of the license server computer.  
 
CGTECH_SINGLE_PLATFORM=YES If you are using VERICUT single Platform then an 
additional environment variable needs to be defined for the interface. 
CGTECH_CATV_LANGUAGE If you want the interface to use something other than US 
English, the variable can specify a file of localized text. Versions for French, German and 
Japanese are supplied.  
 
Use the Microsoft Windows Control Panel > System Properties > Advanced tab > 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information.  
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To add an icon to the Toolbar 
If you wish to have an icon ( ) on a CATIA V5 toolbar, the two icon files must be placed 
where CATIA V5 expects to find them. The paths depend on where you have CATIA V5 
installed, but typically you will find a "small" and "normal" folder under "C:\ Program 
Files\Dassault Systemes\Bxx\win_b64\resources\graphic\icons". Place the two versions 
of the CATV5 icon, both called "I_CATV.bmp", in the appropriate folders.  
Adding the CATV5 icon ( ) to a CATIA V5 toolbar is a multi-step process; 

1. Get CATIA V5 running.  

2. Make the "Advanced Machining" workbench active, either by accessing an 
existing CATProcess file, or by initializing a new one. One or more of the 
Manufacturing toolbars are likely to be suitable locations for the CATV5 icon.  

3. Pick "Tools" > "Macro" > "Macros" from CATIA V5's menus.  

4. In the "Macros" dialog, pick "Macro Libraries".  

5. In the "Macro Libraries" dialog, set the "Library Type" to "Directories".  

6. Pick "Add existing library ..." and select the folder containing the CATV.CATScript 
file (for example "C:\Program Files\CGTech\VERICUT x.x.x\Windows\catv5").  

7. "Close" the "Macro Libraries" dialog.  

8. "Close" the "Macros" dialog.  

9. Pick "Tools" > "Customize ..." from CATIA V5's menus.  

10. In the "Customize" dialog, bring the "Commands" tab to the front.  

11. Select "Macros" from the left-hand list of "Categories".  

12. Pick "CATV.CATScript" from the right-hand list of "Commands".  

13. Click on the "Show Properties ..." button.  

14. Pick the "..." button to the right of the "Icon:" label.  

15. In the "Icon Browser" dialog you need to step through the pages of icons until 
you find the one for CATV5 ( ). The icons are presented in alphabetic order of 
their names, which you can see by allowing the mouse cursor to sit over an icon 
for a brief period. The CATV5 icon ( ) will probably be on the twelfth page. Pick 
it and "Close" the "Icon Browser".  

16. Back on the "Customize" dialog, position the mouse cursor over the name of the 
macro, CATV.CATScript, in the right-hand list, depress the left mouse button, and 
drag the cursor to the toolbar where you want the icon to appear. It's counter-
intuitive, but you drag the macro name, not the icon! Repeat this step if you 
want the icon to appear on more than one toolbar.  

17. "Close" the "Customize" dialog.  
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Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries (Microsoft 
Redistributables). The Microsoft Redistributable vc_redist.x64.exe Installer is also 
available for download at: https://support.microsoft.com/en-ca/help/2977003/the-
latest-supported-visual-c-downloads 
 
 
 
 
 
 

CATIA V5-to-VDAF Interface (CAT2VDAF) 

Prerequisites  
CAT2VDAF is a licensed software program that provides a CATIA V5 to VDAF data 
transfer connection. The interface is an executable that is designed to work with CATIA 
V5.  
 
CATIA V5 Versions supported:  
CATIA V5 R18 (or later) 
 
CGTech Licensing:  
CATIA V5 Interface 
 
Minimum VERICUT Version required:  
VDAF 8.0 
Minimum VERICUT License Version required:  
8.0 
Versions of CATIA V5 tested with CAT2VDAF: 
CATIA V5 (R21) - CATIA V5-6R2019 (R29) 
 
 
 

Installation - Configuration 
For the CAT2VDAF Interface, no user configuration is required. The interface installation 
files are located at C:\Program Files\CGTech\VERICUT x.x.x\windows64\CATV5_2VDAF 
and can be accessed directly from CATIA V5 or C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\commands\catv5_2vdaf.bat 
  

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Environment variables 
To enable the CATIA V5 Interface to find the necessary VERICUT files, you also need to 
define three environment variables, CGTECH_INSTALL, CGTECH_PRODUCTS and 
LSHOST.  CGTECH_SINGLE_PLATFORM is optional.   

No. Environment Variable Example 

1 CGTECH_INSTALL C:\Program Files\CGTech\VERICUT x.x.x 
 

2 CGTECH_PRODUCTS C:\Program Files\CGTech\VERICUT 
x.x.x\windows64  
 

3 LSHOST localhost 
 

4 CGTECH_SINGLE_PLATFORM YES 
 

 
CGTECH_INSTALL is set to the VERICUT installation folder. In the above table, x.x.x 
represents the VERICUT release number. For a typical VERICUT 9.3.2 installation this 
variable is set to C:\Program Files\CGTech\VERICUT 9.3.2.  
Defining a value explicitly for the CGTECH_INSTALL environment variable is optional. It 
can be derived from the CGTECH_PRODUCTS environment variable value. 
 
CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: "windows64". In the above table, x.x.x represents the 
VERICUT release number. For a typical VERICUT 9.3.2 installation this variable is set to 
C:\Program Files\CGTech\VERICUT 9.3.2\windows64.  
 
LSHOST is set to the name of the license server computer.  
 
CGTECH_SINGLE_PLATFORM=YES If you are using VERICUT single Platform then an 
additional environment variable needs to be defined for the interface. 
 
Use the Microsoft Windows Control Panel > System Properties > Advanced tab > 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information.  
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To add an icon to the Toolbar 
If you wish to have an icon ( ) on a CATIA V5 toolbar, the two icon files must be placed 
where CATIA V5 expects to find them. The paths depend on where you have CATIA V5 
installed, but typically you will find a "small" and "normal" folder under "C:\ Program 
Files\Dassault Systemes\Bxx\win_b64\resources\graphic\icons". Place the two versions 
of the CAT2VDAF icon, both called "I_CATV.bmp", in the appropriate folders.  
Adding the CAT2VDAF icon ( ) to a CATIA V5 toolbar is a multi-step process; 

1. Get CATIA V5 running.  

2. Make the "Advanced Machining" workbench active, either by accessing 
an existing CATProcess file, or by initializing a new one. One or more of 
the Manufacturing toolbars are likely to be suitable locations for the 
CAT2VDAF icon.  

3. Pick "Tools" > "Macro" > "Macros" from CATIA V5's menus.  

4. In the "Macros" dialog, pick "Macro Libraries".  

5. In the "Macro Libraries" dialog, set the "Library Type" to "Directories".  

6. Pick "Add existing library ..." and select the folder containing the 
CATV.CATScript file (for example "C:\Program Files\CGTech\VERICUT 
x.x.x\Windows\catv5").  

7. "Close" the "Macro Libraries" dialog.  

8. "Close" the "Macros" dialog.  

9. Pick "Tools" > "Customize ..." from CATIA V5's menus.  

10. In the "Customize" dialog, bring the "Commands" tab to the front.  

11. Select "Macros" from the left-hand list of "Categories".  

12. Pick "CATV.CATScript" from the right-hand list of "Commands".  

13. Click on the "Show Properties ..." button.  

14. Pick the "..." button to the right of the "Icon:" label.  

15. In the "Icon Browser" dialog you need to step through the pages of icons 
until you find the one for CAT2VDAF ( ). The icons are presented in 
alphabetic order of their names, which you can see by allowing the 
mouse cursor to sit over an icon for a brief period. The CAT2VDAF icon (

) will probably be on the twelfth page. Pick it and "Close" the "Icon 
Browser".  

16. Back on the "Customize" dialog, position the mouse cursor over the name 
of the macro, CATV.CATScript, in the right-hand list, depress the left 
mouse button, and drag the cursor to the toolbar where you want the 
icon to appear. It's counter-intuitive, but you drag the macro name, not 
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the icon! Repeat this step if you want the icon to appear on more than 
one toolbar.  

17. "Close" the "Customize" dialog.  

 
 

Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries (Microsoft 
Redistributables). The Microsoft Redistributable vc_redist.x64.exe Installer is also 
available for download at: https://support.microsoft.com/en-ca/help/2977003/the-
latest-supported-visual-c-downloads 
 
 
 
 
 

Creo Parametric-to-VERICUT Interface (PROEV) 

Prerequisites  
PROEV is a licensed software program that provides a Creo to VERICUT data transfer 
connection. The interface is designed to work with Creo Parametric.  
 
Creo Parametric Versions supported:  
PTC Creo Parametric 3.0 (or later) 
 
 
CGTech Licensing:  
PTC Creo Parametric Interface 
 
Minimum VERICUT Version required:  
VERICUT 7.2 
Minimum VERICUT License Version required:  
8.0 
Versions of PTC Creo tested with PROEV: 
PTC CREO Elements Pro 5 - PTC Creo Parametric 7.0 
 
  

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Installation - Configuration 
The CGTech software installation procedure places the files required by PROEV in a sub-
folder. If you elected to install the software in the default folder " C:\Program 
Files\CGTech\VERICUT x.x.x\windows64\proev 
 
Steps 

• Copy the protk.dat file to the “start in” directory per the properties of the 
shortcut.  

 
At startup, Creo Parametric will look for the registry file, protk.dat, to get location 
information about the other files used by the Creo-to-VERICUT Interface. Creo 
Parametric will look for the protk.dat file first in the “start in” directory, then it will look 
in “<Creo>/<MACHINE>/text” and finally it will look in “<Creo>/text.” 
 
The protk.dat file contains the following information: 
name cgtproev  
startup dll 
exec_file <full path, including the file name, where the cgtproev.dll is located>  
text_dir <full directory path to the directory, where the proev.txt file is located>  
revision Wildfire 
end   
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• Edit the protk.dat file to point to the locations of the cgtproev.dll and the 
proev.txt file.  

The protk.dat file specifies the location of the cgtproev.dll file and the proev.txt file. Edit 
exec_file line so that it points to the \proev\Creoxx\cgtproev.dll of your VERICUT 
installation. Edit text_dir line so that it points to the \proev\Creoxx\text directory of 
your VERICUT installation.  
 
The protk.dat file should look similar to the following after editing:  
name cgtproev  
startup dll 
exec_file C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\proev\Creoxx\cgtproev.dll 
text_dir C:\Program Files\CGTech\VERICUT x.x.x\windows64\proev\Creoxx\text 
revision Wildfire 
end 
 

Environment variables 
To enable the Creo Parametric Interface to find the necessary VERICUT files, you also 
need to define three environment variables, CGTECH_INSTALL, CGTECH_PRODUCTS and 
LSHOST.  CGTECH_SINGLE_PLATFORM and PROEV_LANGUAGE are optional.   

No. Environment Variable Example 

1 CGTECH_INSTALL C:\Program Files\CGTech\VERICUT x.x.x 
 

2 CGTECH_PRODUCTS C:\Program Files\CGTech\VERICUT 
x.x.x\windows64  
 

3 LSHOST localhost 
 

4 CGTECH_SINGLE_PLATFORM YES 
 

5 PROEV_LANGUAGE C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\proev\Creoxx\ProevFrench.local  

 
CGTECH_INSTALL is set to the VERICUT installation folder. In the above table, x.x.x 
represents the VERICUT release number. For a typical VERICUT 9.3.2 installation this 
variable is set to C:\Program Files\CGTech\VERICUT 9.3.2.  
Defining a value explicitly for the CGTECH_INSTALL environment variable is optional. It 
can be derived from the CGTECH_PRODUCTS environment variable value. 
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CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: "windows64". In the above table, x.x.x represents the 
VERICUT release number. For a typical VERICUT 9.3.2 installation this variable is set to 
C:\Program Files\CGTech\VERICUT 9.3.2\windows64.  
 
LSHOST is set to the name of the license server computer.  
 
CGTECH_SINGLE_PLATFORM=YES If you are using VERICUT single Platform then an 
additional environment variable needs to be defined for the interface. 
PROEV_LANGUAGE If you want the interface to use something other than US English, 
the variable can specify a file of localized text. Versions for French, German, Italian, 
Portuguese, Chinese and Japanese are supplied.  
 
Use the Microsoft Windows Control Panel > System Properties > Advanced tab > 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information.  
 

To add an icon to the Toolbar 
The proev.txt file contains the resource text for the VERICUT option which shows up in 
Pro/ENGINEER under the "Applications" menu. The VERICUT option is the entry point 
for launching the Creo-to-VERICUT Interface. 
 
Steps 

• Select Customize Quick Access Toolbar > More Commands.. 

 
 

• Customize: Ribbon 
• Category: All Commands 
• Filter Commands: VERICUT  
• Menu Validate 
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• Use arrow  to add VERICUT to the desired location 
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• Select OK 

 
 

Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries (Microsoft 
Redistributables). The Microsoft Redistributable vc_redist.x64.exe Installer is also 
available for download at: https://support.microsoft.com/en-ca/help/2977003/the-
latest-supported-visual-c-downloads 
 
 
 
 
 

Edgecam-to-VERICUT Interface (ECV) 

Prerequisites  
ECV is a licensed software program that provides an Edgecam to VERICUT data transfer 
connection. The interface is a plugin which is designed to work with Edgecam.  
 
Edgecam Versions supported:  
Edgecam 2018 (or later) 
 
CGTech Licensing:  
Edgecam Interface 
 
Minimum VERICUT Version required:  
VERICUT 7.4 
Minimum VERICUT License Version required:  
8.0 
Versions of Edgecam tested with ECV: 
Edgecam 2012 R2 – 2021.0 
 

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Installation - Configuration  
To automatically install the Edgecam to VERICUT interface (ECV), insert the VERICUT 
installation folder of the downloaded VERICUT installer. Next, run the 
edgecam_interface_install.exe and follow the on-screen instructions. 
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Manual installation  
 
NOTE: Before installing the Edgecam Interface files, review where your Edgecam 
installation expects the Plugin. To do this, use Edgecam Launcher ► Settings menu ► 
File Locations 

 
Use this dialog to set the paths for various categories of EDGECAM related files. 
postprocessors, ToolStore data, strategy files, job reports etc are read from and written 
to these locations. You can set multiple locations for a category, including Network 
Location and <USER>.  
By writing files to the user area instead of Program Files, users without administrator 
rights can write data (such as postprocessors and ToolStore data) to that location. Each 
user has his own folder/file set making it more difficult to accidentally overwrite another 
user's data. 
The default settings closely follow Microsoft recommendations for file and folder 
settings. By default, all user created files are written to the user area, replicating the 
installation folder structure. 
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Copy the Edgecam Interface files to your Edgecam installation folder (as shown in the 
below table).  
 
Copy from C:\Program Files\CGTech\VERICUT x.x.x\windows64\edgecam\version 
Copy to C:\Program Files\Hexagon\EDGECAM version 
 

 
 
Copy from: C:\Program Files\CGTech\VERICUT x.x.x\windows64\edgecam\version\icons 
Copy to 
C:\Users\username\Documents\Hexagon\EDGECAM\version\Themes\Default\ribbon 
 
 
NOTE Languages available for ECV: 
Czech  
German  
English  
French  
Italian  
Dutch  
Portuguese 
Nederland  
Chinese  
Japanese 
 
  



Installing CGTech Products 

95 

Environment variables 
To enable the Edgecam Interface to find the necessary VERICUT files, you also need to 
define three environment variables, CGTECH_INSTALL, CGTECH_PRODUCTS and 
LSHOST.  CGTECH_SINGLE_PLATFORM is optional.   

No. Environment Variable Example 

1 CGTECH_INSTALL C:\Program Files\CGTech\VERICUT x.x.x 
 

2 CGTECH_PRODUCTS C:\Program Files\CGTech\VERICUT 
x.x.x\windows64  
 

3 LSHOST localhost 
 

4 CGTECH_SINGLE_PLATFORM YES 
 

 
CGTECH_INSTALL is set to the VERICUT installation folder. In the above table, x.x.x 
represents the VERICUT release number. For a typical VERICUT 9.3.2 installation this 
variable is set to C:\Program Files\CGTech\VERICUT 9.3.2.  
Defining a value explicitly for the CGTECH_INSTALL environment variable is optional. It 
can be derived from the CGTECH_PRODUCTS environment variable value. 
 
CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: "windows64". In the above table, x.x.x represents the 
VERICUT release number. For a typical VERICUT 9.3.2 installation this variable is set to 
C:\Program Files\CGTech\VERICUT 9.3.2\windows64.  
 
LSHOST is set to the name of the license server computer.  
 
CGTECH_SINGLE_PLATFORM=YES If you are using VERICUT single Platform then an 
additional environment variable needs to be defined for the interface. 
 
Use the Microsoft Windows Control Panel > System Properties > Advanced tab > 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information.  
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To add an icon to the Toolbar 
If you wish to have an icon ( ) on an Edgecam toolbar.  

• Select Customize Quick Access Toolbar > More Commands 
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• Select Customize The Ribbon… 
• Select Choose commands from: > User Commands 

 
• Select Active Ribbon > NC Code >  
• Select New Panel 
• Edit Name window > Name: VERICUT 
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• Select OK 

 
• Select VERICUT Export from the Commands column 
• Select Add to move it to the Active Ribbon column  
• Do the same for VERICUT Preferences  

 
• Select OK 
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• Select VERICUT Export, right mouse pick Edit Appearance  
• Button Text: Run VERICUT 
• Button Image: Browse 

C:\Users\username\Documents\Hexagon\EDGECAM\version\Themes\De
fault\ribbon\vericut.ico 

• Check Always large image (32*32) 

 
• Select OK 
• Set up image for VERICUT Preferences 

 
• Select OK 
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Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries (Microsoft 
Redistributables). The Microsoft Redistributable vc_redist.x64.exe Installer is also 
available for download at: https://support.microsoft.com/en-ca/help/2977003/the-
latest-supported-visual-c-downloads 
 
 
 
 
 
 

ESPRIT-to-VERICUT Interface (ESV) 

Prerequisites  
ESV is a licensed software program that provides an ESPRIT to VERICUT data transfer 
connection. The interface is an executable that is designed to work with ESPRIT.  
 
Esprit Versions supported:  
Esprit V18.1.6 (or later) 
 
CGTech Licensing:  
Esprit Interface 
 
Minimum VERICUT Version required:  
VERICUT 7.1 
Minimum VERICUT License Version required:  
8.0 
Versions of Esprit tested with ESV: 
Esprit V18.1.6 - V19.19.191 
 
 
 
 
 
 
 
 
 
 

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Installation - Configuration  
To automatically install the Esprit to VERICUT interface (ESV), insert the VERICUT 
installation folder of the downloaded VERICUT installer. Next, run the 
esprit_interface_install.exe and follow the on-screen instructions. 
 

  
 
Manual installation  
The following section describes how to install the ESPRIT-to-VERICUT Interface without 
using the installer. ESPRIT requires that Add-Ins write values to the registry, because of 
this, you must have administrator privileges to run these scripts.  
  
First, create a directory named VericutAddin in your ESPRIT AddIns folder. If you have 
ESPRIT installed in the default location, the folder you will need to create will be at 
C:\Program Files (x86)\D.P.Technology\ESPRIT\AddIns\VericutAddin.  
  
 
Next, copy all the provided source files into your VericutAddin directory. 
Copy from C:\Program Files\CGTech\VERICUT x.x.x\windows64\esprit 
Copy to C:\Program Files (x86)\D.P.Technology\ESPRIT\AddIns\VericutAddin 
 
 
Register the interface 
Next, you will need to register your files with the Windows registry and with ESPRIT so 
that it will be able to find the Add-In when starting up.  
  



Installing CGTech Products 

102 

You will need to double-click the file register-vericut-addin-64.reg. After double-clicking 
the file, you will be asked to confirm if you want to add an entry to the registry. Select 
yes and you should receive a confirmation message that the value was added 
successfully to the registry. 
NOTE: You must have Administrator privileges run register-vericut-addin-64.reg.  
  
 

Environment variables 
To enable the Esprit Interface to find the necessary VERICUT files, you also need to 
define three environment variables, CGTECH_INSTALL, CGTECH_PRODUCTS and 
LSHOST.  CGTECH_SINGLE_PLATFORM and CGTECH_ESPV_LANGUAGE are optional.   

No. Environment Variable Example 

1 CGTECH_INSTALL C:\Program Files\CGTech\VERICUT x.x.x 
 

2 CGTECH_PRODUCTS C:\Program Files\CGTech\VERICUT 
x.x.x\windows64  
 

3 LSHOST localhost 
 

4 CGTECH_SINGLE_PLATFORM YES 
 

5 CGTECH_ESPV_LANGUAGE C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\Esprit\french\EspritRes.local  

 
CGTECH_INSTALL is set to the VERICUT installation folder. In the above table, x.x.x 
represents the VERICUT release number. For a typical VERICUT 9.3.2 installation this 
variable is set to C:\Program Files\CGTech\VERICUT 9.3.2.  
Defining a value explicitly for the CGTECH_INSTALL environment variable is optional. It 
can be derived from the CGTECH_PRODUCTS environment variable value. 
 
CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: "windows64". In the above table, x.x.x represents the 
VERICUT release number. For a typical VERICUT 9.3.2 installation this variable is set to 
C:\Program Files\CGTech\VERICUT 9.3.2\windows64.  
 
LSHOST is set to the name of the license server computer.  
 
CGTECH_SINGLE_PLATFORM=YES If you are using VERICUT single Platform then an 
additional environment variable needs to be defined for the interface. 
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CGTECH_ESPV_LANGUAGE If you want the interface to use something other than US 
English, the variable can specify a file of localized text. Versions for French, German, 
Italian, Chinese, Portuguese, and Japanese are supplied.  
 
Use the Microsoft Windows Control Panel > System Properties > Advanced tab > 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information.  
 
 

To add an icon to the Toolbar 
No configuration is required  
 
 

Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries (Microsoft 
Redistributables). The Microsoft Redistributable vc_redist.x64.exe Installer is also 
available for download at: https://support.microsoft.com/en-ca/help/2977003/the-
latest-supported-visual-c-downloads 
 
 
 

GibbsCAM-to-VERICUT Interface (GibbsV) 

Prerequisites  
GibbsV is a licensed software program that provides a GibbsCAM to VERICUT data 
transfer connection. The interface is an executable that is designed to work with 
GibbsCAM.  
 
GibbsCAM Versions supported:  
GibbsCAM 2014 (or later) 
 
CGTech Licensing:  
GibbsCAM Interface 
 
Minimum VERICUT Version required:  
VERICUT 7.3 
Minimum VERICUT License Version required:  
8.0 
Versions of GibbsCAM tested with GibbsV: 
GibbsCAM V9.5.2 – V13.0.3 

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Installation - Configuration 
To automatically install the GibbsCAM to VERICUT interface (GibbsV), insert the 
VERICUT installation folder of the downloaded VERICUT installer. Next, run the 
gibbscam_interface_install.exe and follow the on-screen instructions. 

 
 
Manual installation  
The following section describes how to install the GibbsCAM-to-VERICUT Interface 
without using the installer. The GibbsV-to-VERICUT Interface is distributed as two files; 
GibbsV.dll (the code) 
Gibbsv[language].local (localization file) 
 
Copy from C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\GibbsV\version\GibbsV.dll 
Copy to C:\Program Files\3D Systems\GibbsCAM\version\PlugIns\GibbsV.dll 
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Environment variables 
To enable the GibbsCAM Interface to find the necessary VERICUT files, you also need to 
define three environment variables, CGTECH_INSTALL, CGTECH_PRODUCTS and 
LSHOST.  CGTECH_SINGLE_PLATFORM and GIBBSV_LANGUAGE are optional.   

No. Environment Variable Example 

1 CGTECH_INSTALL C:\Program Files\CGTech\VERICUT x.x.x 
 

2 CGTECH_PRODUCTS C:\Program Files\CGTech\VERICUT x.x.x\windows64  
 

3 LSHOST localhost 
 

4 CGTECH_SINGLE_PLATFORM YES 
 

5 GIBBSV_LANGUAGE C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\GibbsV\version\GibbsvJapanese.local 
 

 
CGTECH_INSTALL is set to the VERICUT installation folder. In the above table, x.x.x 
represents the VERICUT release number. For a typical VERICUT 9.3.2 installation this 
variable is set to C:\Program Files\CGTech\VERICUT 9.3.2.  
Defining a value explicitly for the CGTECH_INSTALL environment variable is optional. It 
can be derived from the CGTECH_PRODUCTS environment variable value. 
 
CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: "windows64". In the above table, x.x.x represents the 
VERICUT release number. For a typical VERICUT 9.3.2 installation this variable is set to 
C:\Program Files\CGTech\VERICUT 9.3.2\windows64.  
 
LSHOST is set to the name of the license server computer.  
 
CGTECH_SINGLE_PLATFORM=YES If you are using VERICUT single Platform then an 
additional environment variable needs to be defined for the interface. 
GIBBSV_LANGUAGE If you want the interface to use something other than US English, 
the variable can specify a file of localized text. Versions for French, German, Italian, 
Chinese, and Japanese are supplied.  
 
Use the Microsoft Windows Control Panel > System Properties > Advanced tab > 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information.  
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To add an icon to the Toolbar 
If you wish to have an icon ( ) to the GibbsCAM toolbar… 

• From the GibbsCAM Toolbar, right click and select Customize Toolbar & Menus  
 

 
 

• Select the VERICUT command, then drag and drop it onto the GibbsCAM 
Toolbar. 

 

 

 
• Close the Customize Toolbar & Menus window  
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Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries (Microsoft 
Redistributables). The Microsoft Redistributable vc_redist.x64.exe Installer is also 
available for download at: https://support.microsoft.com/en-ca/help/2977003/the-
latest-supported-visual-c-downloads 
 
 
 
 
 
 

Mastercam-to-VERICUT Interface (McamV) 

Prerequisites  
MCAMV is a licensed software program that provides a Mastercam to VERICUT data 
transfer connection. The interface is a C-Hook that is designed to work with Mastercam.  
 
Mastercam Versions supported:  
Mastercam 2018 (or later) 
 
CGTech Licensing:  
Mastercam Interface 
 
Minimum VERICUT Version required:  
VERICUT 8.0 
Minimum VERICUT License Version required:  
8.0 
Versions of Mastercam tested with MCAMV: 
Mastercam X6 – 2021 
 
 

Installation - Configuration 
To automatically install the Mastercam to VERICUT interface (McamV), insert the 
VERICUT installation folder of the downloaded VERICUT installer. Next, run the 
mastercam_interface_install.exe and follow the on-screen instructions. 

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Manual installation  
The following section describes how to install the Mastercam-to-VERICUT Interface 
without using the installer. This VERICUT C-Hook is for Mastercam xxxx. It is distributed 
as seven files located in the C:\Program Files\cgtech\VERICUT 
x.x.x\windows64\mcamv\Xv\ directory of the VERICUT installation. The x.x.x represents 
the VERICUT release number.  
 
VERICUT.dll (the code) 
VericutSupport.dll (supporting code) 
VericutSupport1.dll (supporting code) 
SetStock.dll (gets the parameters for a Lathe Stock from Mastercam source code) 
VERICUT.ft (used to map an Icon into the Mastercam menu interface)  
GetXFormDependents.dll (supporting code) 
mcRes.local (language translation) 
 
NOTE: Languages supported by McamV: 
German  
English  
French  
Portuguese 
Chinese  
Japanese 
 
The five .dll files and the .ft file should be placed in Mastercam's "chooks" folder and the 
file mcRes.local should be placed in the Mastercam installation folder.  
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Copy from C:\Program Files\CGTech\VERICUT x.x.x\windows64\mcamv\version 
Copy to C:\Program Files\Mastercam version\Mastercam\chooks 
 
VERICUT.dll  
VericutSupport.dll  
VericutSupport1.dll  
SetStock.dll  
VERICUT.ft  
GetXFormDependents.dll  
 
Copy from C:\Program Files\CGTech\VERICUT x.x.x\windows64\mcamv\version 
Copy to C:\Program Files\Mastercam version\Mastercam\ 
 
mcRes.local  
 

Environment variables 
To enable the Mastercam Interface to find the necessary VERICUT files, you also need to 
define three environment variables, CGTECH_INSTALL, CGTECH_PRODUCTS and 
LSHOST.  CGTECH_SINGLE_PLATFORM is optional.   

No. Environment Variable Example 

1 CGTECH_INSTALL C:\Program Files\CGTech\VERICUT x.x.x 
 

2 CGTECH_PRODUCTS C:\Program Files\CGTech\VERICUT 
x.x.x\windows64  
 

3 LSHOST localhost 
 

4 CGTECH_SINGLE_PLATFORM YES 
 

 
CGTECH_INSTALL is set to the VERICUT installation folder. In the above table, x.x.x 
represents the VERICUT release number. For a typical VERICUT 9.3.2 installation this 
variable is set to C:\Program Files\CGTech\VERICUT 9.3.2.  
Defining a value explicitly for the CGTECH_INSTALL environment variable is optional. It 
can be derived from the CGTECH_PRODUCTS environment variable value. 
 
CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: "windows64". In the above table, x.x.x represents the 
VERICUT release number. For a typical VERICUT 9.3.2 installation this variable is set to 
C:\Program Files\CGTech\VERICUT 9.3.2\windows64.  
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LSHOST is set to the name of the license server computer.  
 
CGTECH_SINGLE_PLATFORM=YES If you are using VERICUT single Platform then an 
additional environment variable needs to be defined for the interface. 
 
Use the Microsoft Windows Control Panel > System Properties > Advanced tab > 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information.  
 
 

To add an icon to the Toolbar 
If you wish to have an icon ( ) on a Mastercam toolbar… 

• From the Mastercam Quick Access Toolbar, select More Commands 

 
 

• Select Customize Ribbon 
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• Add a New Group to the Machine tab 
• Rename to VERICUT and  
• Add the Run VERICUT Icon  
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• Select OK  

 
 
 

Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries (Microsoft 
Redistributables). The Microsoft Redistributable vc_redist.x64.exe Installer is also 
available for download at: https://support.microsoft.com/en-ca/help/2977003/the-
latest-supported-visual-c-downloads 
 
 
 
 
 
 

PowerMill-to-VERICUT Interface (PMV) 

Prerequisites  
PMV is a licensed software program that provides a PowerMill to VERICUT data transfer 
connection. The interface is a Plug-In which is designed to work with PowerMill and 
Autodesk licensing levels: Regular, Premium or Ultimate 
 
PowerMill Versions supported:  
PowerMill 2020 (or later)  
 
CGTech Licensing:  
PowerMill Interface 
 
Minimum VERICUT Version required:  
VERICUT 8.2 
Minimum VERICUT License Version required:  
8.2 
Versions of PowerMill tested with PMV: 
PowerMill 2020 – 2021 

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Installation - Configuration 
To automatically install the PowerMill to VERICUT interface (PMV), insert the VERICUT 
installation folder of the downloaded VERICUT installer. Next, run the 
powermill_interface_install.exe and follow the on-screen instructions. 
 

   
 
Manual installation  
The powermill_interface_install.exe installs and configures the below requirements. The 
following section describes how to install the PowerMill-to-VERICUT Interface without 
using the installer. PowerMill is distributed as ten files and requires that Plug-Ins write 
values to the registry, because of this, you must have administrator privileges to run this 
script.  
  
Copy Plug-In files  
CviView.dll 
CviViewModel.dll 
PluginFramework.dll 
PowerMill.dll 
VericutEng.dll 
VericutPlugin.dll 
vericut.ico 
vericut_setup.ico 
PowerMill.local 
register-pmv.bat 
Create to a directory next to the PowerMill installation path.  
Copy from C:\Program Files\CGTech\VERICUT x.x.x\windows64\PowerMill\2020 
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Copy to C:\Program Files\Autodesk\PowerMill VERICUT Plugin 
 
 
Register the interface 
Next, you will need to register your files with the Windows registry and with PowerMill 
so that it will be able to find the Plug-In when starting up.  
  
You will need to double-click the file register-pmv.bat. After double-clicking the file, you 
will be asked to confirm if you want to add an entry to the registry. Select yes and you 
should receive a confirmation message that the value was added successfully to the 
registry. 
NOTE: You must have Administrator privileges run register-pmv.bat  
 
Enable the Interface 
 

 
 
Click File tab > Options > Manage Installed Plugins to display the Plugin Manager dialog 
where you can manage the plugins that are installed on your PC.  
Select the PowerMIll-VERICUT Interface and pick Enable 
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Environment variables 
To enable the PowerMill Interface to find the necessary VERICUT files, you also need to 
define three environment variables, CGTECH_INSTALL, CGTECH_PRODUCTS and 
LSHOST.  CGTECH_SINGLE_PLATFORM is optional.   

No. Environment Variable Example 

1 CGTECH_INSTALL C:\Program Files\CGTech\VERICUT x.x.x 
  

2 CGTECH_PRODUCTS C:\Program Files\CGTech\VERICUT 
x.x.x\windows64  
  

3 LSHOST localhost 
  

4 CGTECH_SINGLE_PLATFORM YES 
  

 
CGTECH_INSTALL is set to the VERICUT installation folder. In the above table, x.x.x 
represents the VERICUT release number. For a typical VERICUT 9.3.2 installation this 
variable is set to C:\Program Files\CGTech\VERICUT 9.3.2.  
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Defining a value explicitly for the CGTECH_INSTALL environment variable is optional. It 
can be derived from the CGTECH_PRODUCTS environment variable value. 
 
CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: "windows64". In the above table, x.x.x represents the 
VERICUT release number. For a typical VERICUT 9.3.2 installation this variable is set to 
C:\Program Files\CGTech\VERICUT 9.3.2\windows64.  
 
LSHOST is set to the name of the license server computer.  
 
CGTECH_SINGLE_PLATFORM=YES If you are using VERICUT single Platform then an 
additional environment variable needs to be defined for the interface. 
 
Use the Microsoft Windows Control Panel > System Properties > Advanced tab > 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information.  
 

To add an icon to the Toolbar 
Note: the powermill_interface_install.exe should configure the VERICUT Interface icons 
on the PowerMill toolbar. 
Reference: 
C:\Users\user_name\AppData\Local\Autodesk\PowerMill\ribbon_customisation.xml 
 
Manual steps to configure toolbar: 
If you wish to have an icon ( ) on the PowerMill toolbar.  

• Select Customize Quick Access Toolbar > More Commands 
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• Select Customize Ribbon 
• Select Command button 

 
• Select New Tab  
• Select Edit > Name: VERICUT 
• Select Done 
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• Select New Group 
• Select Edit > Name: VERICUT Interface 
• Select Done 

 
 

• Add 2 Commands to the group 
• Name: Export Projects 
• Description: VERICUT Interface 
• Command: PLUGIN {B54AB951-1005-45CC-9922-E2BF5B69C494} export 

project 
• Picture: select Open and browse C:\Program Files\Autodesk\PowerMill 

VERICUT Plugin 2020\icons\vericut.ico 
• Select Add 

 
• Name: Preferences 
• Description: VERICUT Interface 
• Command: PLUGIN {B54AB951-1005-45CC-9922-E2BF5B69C494} edit 

preferences 
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• Picture: select Open and browse C:\Program Files\Autodesk\PowerMill 
VERICUT Plugin 2020\icons\vericut_setup.ico 

• Select Add 

 
• Select OK 

 
Optionally, you could add the VERICUT Interface launch commands to a right click menu 
in PowerMill. 

• Unzip the supplied Right_click_menu_configuration file 
• Add customized path to point to the folder 

File>>Options>>Customized Paths>>Macro Paths 

 
• Right Click in empty tree area 

file://xserve.cgtech.local/fileserver/CGTech/Tech_Tools/INTERNAL_USE_ONLY/Interfaces/PowerMILL_CGT_PMV/Samples/Right_click_menu_configuration/pmill4.zip
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Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries (Microsoft 
Redistributables). The Microsoft Redistributable vc_redist.x64.exe Installer is also 
available for download at: https://support.microsoft.com/en-ca/help/2977003/the-
latest-supported-visual-c-downloads 
 
 
 
 
 
 

Siemens NX-to-VERICUT Interface (NXV) 

Prerequisites  
NXV is a licensed software program that provides a Siemens NX to VERICUT data 
transfer  
 
Siemens NX Versions supported:  
Siemens NX 11 (or later) 
 
CGTech Licensing:  
NX Interface 
 
Minimum VERICUT Version required:  
VERICUT 8.0 
Minimum VERICUT License Version required:  
8.0 
Versions of Siemens NX tested with NXV: 

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Siemens NX 8 – CR 1919 

Installation - Configuration 
For the Siemens NX Interface, no user configuration is required. The interface 
installation files are located at C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\nx\version and can be accessed by C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\commands\nx(version).bat  
 

Environment variables 
To enable the Siemens NX Interface to find the necessary VERICUT files, you also need 
to define three environment variables, CGTECH_INSTALL, CGTECH_PRODUCTS and 
LSHOST.  CGTECH_SINGLE_PLATFORM and UGII_VENDOR_DIR are optional.   

No. Environment Variable Example 

1 CGTECH_INSTALL C:\Program Files\CGTech\VERICUT x.x.x 
 

2 CGTECH_PRODUCTS C:\Program Files\CGTech\VERICUT 
x.x.x\windows64  
 

3 LSHOST localhost 
 

4 CGTECH_SINGLE_PLATFORM YES 
 

5 UGII_VENDOR_DIR C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\nx\NXxx\french 
 

 
CGTECH_INSTALL is set to the VERICUT installation folder. In the above table, x.x.x 
represents the VERICUT release number. For a typical VERICUT 9.3.2 installation this 
variable is set to C:\Program Files\CGTech\VERICUT 9.3.2.  
Defining a value explicitly for the CGTECH_INSTALL environment variable is optional. It 
can be derived from the CGTECH_PRODUCTS environment variable value. 
 
CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: "windows64". In the above table, x.x.x represents the 
VERICUT release number. For a typical VERICUT 9.3.2 installation this variable is set to 
C:\Program Files\CGTech\VERICUT 9.3.2\windows64.  
 
LSHOST is set to the name of the license server computer.  
 
CGTECH_SINGLE_PLATFORM=YES If you are using VERICUT single Platform then an 
additional environment variable needs to be defined for the interface. 
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UGII_VENDOR_DIR If you want the interface to use something other than US English, 
the variable can specify a file of localized text. Versions for French, German, Chinese, 
Czech, and Japanese are supplied.  
 
Use the Microsoft Windows Control Panel > System Properties > Advanced tab > 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information.  
 

To add an icon to the Toolbar 
If you wish to have an icon ( ) on an NX toolbar…  

• Select Toolbar Options   

 
• Customize 
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• Search for VERICUT  

 
 

• Drag and Drop command to desired location 

 
• Select Close  
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Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries (Microsoft 
Redistributables). The Microsoft Redistributable vc_redist.x64.exe Installer is also 
available for download at: https://support.microsoft.com/en-ca/help/2977003/the-
latest-supported-visual-c-downloads 
 
 
 
 
 
 

Siemens NX-to-VDAF Interface (NX2VDAF) 

Prerequisites  
NX2VDAF is a licensed software program that provides a Siemens NX to VDAF data 
transfer  
 
NX Versions supported:  
Siemens NX 11 (or later) 
 
CGTech Licensing:  
NX Interface 
 
Minimum VERICUT Version required:  
VDAF 7.4 
Minimum VERICUT License Version required:  
8.0 
Versions of Siemens NX tested with NX2VDAF: 
Siemens NX 8 – CR 1911 
 
 
 

Installation - Configuration 
For the Siemens NX Interface, no user configuration is required. The interface 
installation files are located at C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\nx2vdaf\version and can be accessed by C:\Program 
Files\CGTech\VERICUT x.x.x\windows64\commands\nx(version) _2vdaf.bat  
  
  

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Environment variables 
To enable the Siemens NX Interface to find the necessary VERICUT files, you also need 
to define three environment variables, CGTECH_INSTALL, CGTECH_PRODUCTS and 
LSHOST.  CGTECH_SINGLE_PLATFORM is optional.   

No. Environment Variable Example 

1 CGTECH_INSTALL C:\Program Files\CGTech\VERICUT x.x.x 
 

2 CGTECH_PRODUCTS C:\Program Files\CGTech\VERICUT 
x.x.x\windows64  
 

3 LSHOST localhost 
 

4 CGTECH_SINGLE_PLATFORM YES 
 

 
CGTECH_INSTALL is set to the VERICUT installation folder. In the above table, x.x.x 
represents the VERICUT release number. For a typical VERICUT 9.3.2 installation this 
variable is set to C:\Program Files\CGTech\VERICUT 9.3.2.  
Defining a value explicitly for the CGTECH_INSTALL environment variable is optional. It 
can be derived from the CGTECH_PRODUCTS environment variable value. 
 
CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: "windows64". In the above table, x.x.x represents the 
VERICUT release number. For a typical VERICUT 9.3.2 installation this variable is set to 
C:\Program Files\CGTech\VERICUT 9.3.2\windows64.  
 
LSHOST is set to the name of the license server computer.  
 
CGTECH_SINGLE_PLATFORM=YES If you are using VERICUT single Platform then an 
additional environment variable needs to be defined for the interface. 
 
Use the Microsoft Windows Control Panel > System Properties > Advanced tab > 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information.  
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To add an icon to the Toolbar 

If you wish to have an icon ( ) on an NX toolbar…  
• Select Toolbar Options   

 
• Customize 
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• Search for VDAF  

 
 

• Drag and Drop command to desired location 

  
• Select Close  
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Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries (Microsoft 
Redistributables). The Microsoft Redistributable vc_redist.x64.exe Installer is also 
available for download at: https://support.microsoft.com/en-ca/help/2977003/the-
latest-supported-visual-c-downloads 
 
 
 
 
 
 

SURFCAM-to-VERICUT Interface (SCV) 

Prerequisites  
SCV is a licensed software program that provides a SURFCAM to VERICUT data transfer 
connection. The interface is an executable that is designed to work with SURFCAM.  
 
SURFCAM Versions supported:  
SURFCAM V6 (or later) 
 
CGTech Licensing:  
Surfcam Interface 
 
Minimum VERICUT Version required:  
VERICUT 7.2 
Minimum VERICUT License Version required:  
8.0 
Versions of Surfcam tested with SCV: 
SURFCAM V6 – 2020.0 
 
 
 

Installation - Configuration 
The following section describes how to install the SURFCAM-to-VERICUT Interface. SCV 
is distributed as three files located in the C:\Program Files\cgtech\VERICUT 
x.x.x\windows64\surfcam directory of the VERICUT installation.  
 
Vericut_Interface.dll (the code) 
StyleSheet.xsl (supporting code) 
SurfcamRes.local (language translation) 

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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NOTE Languages supported by SCV: 
English  
French  
Portuguese 
Chinese  
Japanese 
Italian  
 
 
 
Steps: 
• Copy from C:\Program Files\cgtech\VERICUT x.x.x\windows64\surfcam 
Copy to C:\Users\Public\Surfcam\Surfcamxx\UserApps\VERICUT 
 
Note: You will have to create UserApps and VERICUT directories manually. 
 
• Edit the ‘SURFCAM.INI’ file in order for Surfcam to get the location of addin dll. 
SURFCAM.INI file can be found at “C:\Users\Public\Surfcam\Surfcamx.x\Config” 
location. Please, right click and open the file in an editor. You will have to look for 
‘Specify Plug-Ins option’ section. And make the following changes into it. 
  
;___________ Specify Plug-Ins option ____________ 
UserApplications=1 
UserApp1=C:\Users\Public\Surfcam\Surfcamx.x\UserApps\VERICUT\Vericut_Interface.d
ll,"VERICUT Interface"  
  
• Save the file. 
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Environment variables 
To enable the SURFCAM Interface to find the necessary VERICUT files, you also need to 
define three environment variables, CGTECH_INSTALL, CGTECH_PRODUCTS and 
LSHOST.  CGTECH_SINGLE_PLATFORM, CGTECH_SURFCAM_LANGUAGE and are 
CGTECH_SURFCAM_LOCALE optional.   

No. Environment Variable Example 
1 CGTECH_INSTALL C:\Program Files\CGTech\VERICUT x.x.x 

 
2 CGTECH_PRODUCTS C:\Program Files\CGTech\VERICUT 

x.x.x\windows64  
 

3 LSHOST localhost 
 

4 CGTECH_SINGLE_PLATFORM YES 
 

5 CGTECH_SURFCAM_LANGUAGE C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\surfcam\french 

6 CGTECH_SURFCAM_LOCALE french 
 

 
CGTECH_INSTALL is set to the VERICUT installation folder. In the above table, x.x.x 
represents the VERICUT release number. For a typical VERICUT 9.3.2 installation this 
variable is set to C:\Program Files\CGTech\VERICUT 9.3.2.  
Defining a value explicitly for the CGTECH_INSTALL environment variable is optional. It 
can be derived from the CGTECH_PRODUCTS environment variable value. 
 
CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: "windows64". In the above table, x.x.x represents the 
VERICUT release number. For a typical VERICUT 9.3.2 installation this variable is set to 
C:\Program Files\CGTech\VERICUT 9.3.2\windows64.  
 
LSHOST is set to the name of the license server computer.  
 
CGTECH_SINGLE_PLATFORM=YES If you are using VERICUT single Platform then an 
additional environment variable needs to be defined for the interface. 
CGTECH_SURFCAM_LANGUAGE If you want the interface to use something other than 
US English, the variable can specify path of the local file. Versions for French, Chinese, 
Italian, Portuguese, and Japanese are supplied. CGTECH_SURFCAM_LOCALE is used to 
define name of the language; which user prefers to display on the interface 
 
Use the Microsoft Windows Control Panel > System Properties > Advanced tab > 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information.  
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To add an icon to the Toolbar 
No configuration is required  
 
 

Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries (Microsoft 
Redistributables). The Microsoft Redistributable vc_redist.x64.exe Installer is also 
available for download at: https://support.microsoft.com/en-ca/help/2977003/the-
latest-supported-visual-c-downloads 
 
 

 
 
 
 
 
 

  

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Configuring the Teamcenter Interface (TCI) 
  
This section documents the necessary steps make to the Teamcenter Interface to work 
in your environment.  There are several configuration steps that need to be completed 
and several software versions that must be met.  These instructions apply only when 
connecting VERICUT with Teamcenter. 
 
Software Prerequisites 
 
The Teamcenter Interface has several software version requirements. 

• Siemens software prerequisites: 
o NX version 10 or higher 
o Teamcenter version 10 or higher 
o MRL (Manufacturing Resource Library) version3.1.5 or higher, if MRL is 

being used 
o SFC (ShopFloor Connect) version 2017.4 or higher 

• VERICUT software prerequisites: 
o VERICUT 9.3.2 or higher  
o NXV Interface 
o Teamcenter Interface 

 
 
License Prerequisites 
 
The Teamcenter Interface requires an additional software license from Siemens to work: 

• (TCM55072) Siemens 3rd party CAM access to Teamcenter MRL license 
 
  
Configuration 
 

• SFC (ShopFloor Connection) Configuration 
o Contact technical support for help in configuring SFC to work with the 

Teamcenter Integration 
o This process must be done in order for the interface to work properly. 

• Local Computer Configuration 
o Ensure the correct environment variables are set for the current version 

of NX that is being used. 
 Variable Value 

UGII_BASE_DIR C:\Program Files\Siemens\NX 10.0\ 
 

UGII_ROOT_DIRC :\Program Files\Siemens\NX 10.0\UGII 
 

o These variables should be set correctly from the installation of NX 
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• VERICUT Configuration 

o Ensure the following variables are set correctly in the vericut.bat and 
toolman.bat files 

 
  

Variable Value 
CGTECH_TC_WORKPLACE Used to set Teamcenter workplace. 

Expected value - vericut 
CGTECH_TC_NXP_TYPE Defines Teamcenter item type for NX Projects 

Expected value - MENCMachining 
CGTECH_TC_TOOL_TYPE Defines Teamcenter item type for NX Tools 

Expected value - MENCTool 
 
   
NOTE:  A workplace named ‘vericut’ should be defined when SFC is configured.  If a 
different workplace name is used during the configuration that name should be used for 
this variable.If different item types are used in Teamcenter for NX CAM projects and 
cutting tool assemblies, those item names need to be entered as values for the above 
variables. 
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Configuring the VERICUT TDM Systems Interface 
 

VERICUT has the ability to connect to both TDM databases that TDM Systems currently 
offers: 

– TDM (commonly referred to as “V4” or TDM “Classic”) 

– TDM Global Line 

The determination of which VERICUT to TDM Interface to use will depend on which TDM 
tool data management system you are intending to connect with.  Both the TDM 
Interface and TDM Global Line Interface are separate optional licenses that are 
necessary to connect to the appropriate TDM database. 

  

Configuration of the TDM Interface (commonly referred to as “V4” or TDM “Classic”) 

VERICUT connects to the TDM Systems tool management database using a Dynamic Link 
Library (DLL) supplied by TDM Systems. It is mandatory to use the DLL supplied with 
your specific TDM installation since the DLL is both specific to the TDM version and to 
the Oracle database version. The following steps must be followed to configure the 
installation in order for the TDM icon to activate in Tool Manager. 

This TDM Interface will use the following TDM Icon in Tool Manager.  By default this 
icon will be greyed out until your computer is configured per the steps below. 

 
Check to ensure the customer’s license includes the optional TDM Interface license in 
VERICUT. This license is necessary to connect to the TDM database. To do this, launch 
VERICUT > Help ribbon > License. Scroll down and find ‘TDM Interface’. If this license is 
not listed, contact your local CGTech representative. 
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The following environment variables need to be set in your local computer: 

 
Variable Name:  CGT_EXTERNAL_JAR_FILES 

Path:  c:\TDM\java\classes;C:TDM\java\lib\SwisSQLAPI.jar 

CGT_EXTERNAL_JAR_FILES environment variable is setup manually on your local 
computer to point to the following locations.  Both paths are necessary. 

c:\TDM\java\classes 

C:TDM\java\lib\SwisSQLAPI.jar 

Variable Name:  CGT_EXTERNAL_DLL_PATH 

Path:  C:\TDM\Sys\iMVCT\x64 

CGT_EXTERNAL_DLL_PATH environment variable is setup manually on your local 
compute to point to the location in TDM where the .dll’s and .ini files are located. 

When these edits are completed, VERICUT’s TDM Interface can then be invoked from 
the Tool Manager > Import ribbon > TDM icon. 
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Alternately, the previous method of modifying the vericut.bat file and copying the .dll 
files and tms.ini files into the appropriate folder will work to successfully configure the 
TDM Interface to VERICUT but it is strongly recommended to use the above 
configuration process going forward.  Please contact TDM or CGTech’s technical support 
for more information regarding this configuration. 

  

Configuration of the TDM Global Line Interface 

VERICUT connects to the TDM Global Line tool management database using an https 
address along with a Username and password.  This interface does not any modification 
of the vericut.bat or toolman.bat files nor any .dll files or tms.ini files. 

This TDM Global Line Interface will use the following TDM Icon in Tool Manager.  By 
default this icon is active. 

 
Check to ensure the customer’s license includes the optional TDM Interface license in 
VERICUT. This license is necessary to connect to the TDM database. To do this, launch 
VERICUT > Help ribbon > License. Scroll down and find ‘TDM Interface’. If this license is 
not listed, contact your local CGTech representative. 

 
Click the TDM Global Line icon to invoke the TDM Global Line Interface. 

The first time the TDM Global Line Interface is opened enter the following information 
into the appropriate fields at the top of the interface: 

User 

Password 

Base URl 
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Once the correct information is entered click Connect.  Upon a successful connection 
the light will turn green and the User, Password, and Base URl will be stored in an 
encrypted .config file within Windows. 

 
Subsequent activation of the TDM Global Line Interface icon will automatically recall the 
encrypted User, Password, and Base URl information and populate the appropriate 
fields.  The user only needs to click Connect to use the TDM Global Line Interface. 

 

Return to “Other Configuration Tasks” 
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Configuring the WinTool Interface 
 
VERICUT has the ability to easily use 3D tooling generated from the WinTool tool data 
management system.  WinTool is an independent tool database management system. 
 
WinTool generates a .tls file for use in VERICUT’s Tool Manager.  This .tls file can be 
generated independently from VERICUT or from launching the WT-Tool Export 
executable (for example "C:\Program Files (x86)\WinTool\WT-VERICUT-Interface\WT-
ToolExport.exe") via the WinTool icon from Tool Manager’s Import ribbon. 
 
The WinTool icon in VERICUT’s Tool Manager is inactive, by default.  Installation of the 
WinTool tool data management software is a requirement in order to use the WinTool 
icon within Tool Manager.  The icon will automatically become active if WinTool 
software is installed and one of the following criteria are met.  These criteria are 
checked in the following order: 
 

• ‘CGTECH_WINTOOL’ environment variable (should be defined during WinTool 
installation) 

• .exe file path is set in VERICUT Tool Manager’s Preference dialog under CAD Tool 
Import Executables section 

• Windows registry (should be defined during WinTool installation) 
 
The WinTool configuration and installation instructions are part of the WinTool install 
documents by WinTool AG.  For further details on the WinTool WT-ToolExport interface 
see the WT-VERICUT-Interface-Manual-E.pdf (for example: C:\Program Files 
(x86)\WinTool\WT-VERICUT-Interface\Docs\WT-VERICUT-Interface-Manual-E.pdf) or 
contact WinTool.  
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Configuring the Zoller Interface 
The ZOLLER Interface to VERICUT allows for configuration for different options 
depending on the users needs and setup with ZOLLER TMS. 

 

Prioritization/Control of Graphics 

The ZOLLER Interface can be configured to control the priority and limitation of graphics 
to be read from the ZOLLER TMS database. This configuration is optional and ONLY for 
situations where the user needs to prioritize the order of graphics to be read into 
VERICUT’s Tool Manager that does not follow the default order of graphics.  

By default the ZOLLER Interface will look for and read the following graphic file formats 
for each tool type from the ZOLLER TMS database.  

For milling/drilling (spinning) tools:  

1. SVG Contour (similar to a DXF)  

2. (If SVG Contour does not exist) .STEP/.stp file located in ‘GraphicFile’  

For turning tools:  

1. .STEP/.stp file located in ‘GraphicFile’  

The ZOLLER database has the option to contain up to 10 types of graphics files for each 
tool assembly to read 3D graphics models from. These nine graphics are displayed in the 
ZOLLER TMS software as shown below in the ZOLLER window.  
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1. Main_Graphics 

2. Assembly 

3. Webcam 

4. CAM_3D 

5. Scan_3D 

6. CAD_3D 

7. Free 

8. Free2 

9. CAZ 

 

The SVG Contour is the 10th graphics file option within ZOLLER TMS. It is a 2D format, 
similar to a DXF file. It is not displayed in the above ZOLLER TMS dialog nor is it 
configurable with the environment variables listed below. 

If the SVG Contour file is desired, within the ZOLLER Database Access window, uncheck 
the box next in the STEP column. This will first look for the SVG Contour file for that 
specific tool assembly. 

If the user needs to prioritize or limit the order of graphics being read in for tool 
assemblies through the ZOLLER Interface set the following environment variables in the 
vericut.bat and toolman.bat files: 

For milling/drilling (spinning) tools - CGTECH_ZOLLER_MILL_TOOL_ORDER 

For turning tools - CGTECH_ZOLLER_LATHE_TOOL_ORDER 

Examples: (copy and paste these lines into the .bat files then adjust the values 
accordingly) 

set CGTECH_ZOLLER_MILL_TOOL_ORDER=CAM_3D,CAD_3D 

set CGTECH_ZOLLER_LATHE_TOOL_ORDER=CAD_3D,CAM_3D,Free_1 

Edit the vericut.bat and toolman.bat files in a text editor. It is strongly recommended to 
make copies of all files described below prior to the edits and changes. The original files 
can be used for comparison in case there is an issue. 
The order in which the items appear in the list is the order in which the items will be 
checked. If a GraphicFile name is not listed next to the environment variable it will not 
be read. 
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Color Settings for Graphics 
STEP models within ZOLLER TMS should be defined with the correct ISO color standards 
in order for the interface to correctly recognize CUT, NOCUT, NOCUT NOSPIN 
components correctly.   
 
The following are the ISO color standards:  

CUT = RGB Value 205 | 205 | 205 
NOCUT = RGB Value 128 | 128 | 128 
NOCUT NOSPIN = 141 | 141 | 141 

 
If a user needs to adjust the ZOLLER Interface to color changes that were made in their 
ZOLLER TMS, this can be done by adding the following environment variables to the 
vericut.bat and toolman.bat files.  There are individual color settings for the CAD and 
CAM files: 
CAD 

set CGTECH_ZOLLER_CAD_CUT 
set CGTECH_ZOLLER_CAD_NOCUT 
set CGTECH_ZOLLER_CAD_SHAFT 
set CGTECH_ZOLLER_CAD_NOCUT_NOSPIN 
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Installing the Model Interface Modules 
 

Model Interfaces enable VERICUT to read the designated model file formats and use them as 
stock, fixture, design, tool holder and machine models. The modules do not require a CAD/CAM 
system be available for VERICUT to read any of the formats. 

By default, VERICUT includes the ability to use several industry-standard model file formats: 
STEP, STL, IGES and DXF.  

Additionally, the following optional Model Interfaces enable VERICUT to read the designated 
model file formats and use them as stock, fixture, design, tool holder and machine models. The 
modules do not require a CAD/CAM system be available for VERICUT to read any of the formats. 

Ref: https://www.cgtech.com/products/product-line/84-model-interfaces.html 

 

Model Interfaces list: 
1. ACIS 
2. Catia V4 
3. Catia V5 
4. Creo 
5. Siemens NX Spatial 
6. Siemens NX Reader 
7. SolidWorks 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.cgtech.com/products/product-line/84-model-interfaces.html
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ACIS Interface  
The ACIS Model Interface enables VERICUT to read the designated model file formats 
and use them as stock, fixture, design, tools and machine models. 

Prerequisites  
CGTech Licensing:  
ACIS Model Interface 
 
Spatial: 
Spatial iop2020 installed  
 
Supported file extensions: 
.sat 
 
Versions tested: 
ACIS 19.0 – 22.0.1   
 
 

Installation - Configuration 
For the ACIS Model Interface, no user configuration is required.  

The Interface requires the below files are setup correctly, note that this setup is 
done by the VERICUT installer. 

• Spatial folder installed C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\spatial (translator) 

• C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\commands\acisenv.bat (mapping file) 

• The Model interface files are located at C:\Program 
Files\CGTech\VERICUT x.x.x\windows64\vericut\cgtacis.dll (application) 

 

Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries 
(Microsoft Redistributables). The Microsoft Redistributable 
InstallDSSoftwareVC11Prerequisites_x86_x64.msi Installer is also available for 
download at: https://support.microsoft.com/en-ca/help/2977003/the-latest-
supported-visual-c-downloads 

  

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads


Installing CGTech Products 

144 

Usage  
Open > Model File: 

 
 
NOTE: The Interface Checks Out a license when the model is imported and then 
the Interface Checks In the license when the user checks it in or VERICUT is 
closed 
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Catia V4 Interface  
The Catia V4 Model Interface enables VERICUT to read the designated model file 
formats and use them as stock, fixture, design, tools and machine models. 

Prerequisites  
CGTech Licensing:  
CATIA V4 Model Interface 
 
Spatial: 
Spatial iop2020 installed  
 
Supported file extensions: 
.Model 
 
Versions tested: 
Catia V4 Release 2.5 
 
 

Installation - Configuration 
For the Catia V4 Model Interface, no user configuration is required.  

The Interface requires the below files are setup correctly, note that this setup is 
done by the VERICUT installer. 

• Spatial folder installed C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\spatial (translator) 

• C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\commands\acisenv.bat (mapping file) 

• The Model interface files are located at C:\Program 
Files\CGTech\VERICUT x.x.x\windows64\vericut\cgtacis_catiav4.dll 
(application) 

 

Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries 
(Microsoft Redistributables). The Microsoft Redistributable 
InstallDSSoftwareVC11Prerequisites_x86_x64.msi Installer is also available for 
download at: https://support.microsoft.com/en-ca/help/2977003/the-latest-
supported-visual-c-downloads 

  

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Usage 
Open > Model File: 

 
 
NOTE: The Interface Checks Out a license when the model is imported and then 
the Interface Checks In the license when the user checks it in or VERICUT is 
closed 
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Catia V5 Interface  
The Catia V5 Model Interface enables VERICUT to read the designated model file 
formats and use them as stock, fixture, design, tools and machine models. 

Prerequisites  
CGTech Licensing:  
CATIA V5 Model Interface 
 
Spatial: 
Spatial iop2020 installed  
 
Supported file extensions: 
.3dxml 
.CATPart 
.CATProduct 
.cgr 
 
Versions tested: 
Catia R18 - Catia V5-6 2020 (3DXML, CATParts, CATProducts, CGR) 
3DEXPERIENCE 2013 - 2021 (3DXML) 
 
 

Installation - Configuration 
For the Catia V5 Model Interface, no user configuration is required.  

The Interface requires the below files are setup correctly, note that this setup is 
done by the VERICUT installer. 

• Spatial folder installed C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\spatial (translator) 

• C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\commands\acisenv.bat (mapping file) 

• The Model interface files are located at C:\Program 
Files\CGTech\VERICUT x.x.x\windows64\vericut\cgtacis_catiav5.dll 
(application) 

Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries 
(Microsoft Redistributables). The Microsoft Redistributable 
InstallDSSoftwareVC11Prerequisites_x86_x64.msi Installer is also available for 
download at: https://support.microsoft.com/en-ca/help/2977003/the-latest-
supported-visual-c-downloads 

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Usage 
Open > Model File: 

 
 
NOTE: The Interface Checks Out a license when the model is imported and then 
the Interface Checks In the license when the user checks it in or VERICUT is 
closed 
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Creo Interface  
The Creo Model Interface enables VERICUT to read the designated model file formats 
and use them as stock, fixture, design, tools and machine models. 

Prerequisites  
CGTech Licensing:  
PTC Creo Parametric Model Interface 
 
Spatial: 
Spatial iop2020 installed  
 
Supported file extensions: 
.prt 
.asm 
 
Versions tested: 
Creo 3 - 7  
 
 

Installation - Configuration 
For the Creo Model Interface, no user configuration is required.  

The Interface requires the below files are setup correctly, note that this setup is 
done by the VERICUT installer. 

• Spatial folder installed C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\spatial (translator) 

• C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\commands\acisenv.bat (mapping file) 

• The Model interface files are located at C:\Program 
Files\CGTech\VERICUT x.x.x\windows64\vericut\cgtacis_proe.dll 
(application) 

 

Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries 
(Microsoft Redistributables). The Microsoft Redistributable 
InstallDSSoftwareVC11Prerequisites_x86_x64.msi Installer is also available for 
download at: https://support.microsoft.com/en-ca/help/2977003/the-latest-
supported-visual-c-downloads 

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Usage 
Open > Model File: 

 
 
NOTE: The Interface Checks Out a license when the model is imported and then 
the Interface Checks In the license when the user checks it in or VERICUT is 
closed 
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Siemens NX Spatial Interface  
The Siemens NX Spatial Model Interface enables VERICUT to read the designated model 
file formats and use them as stock, fixture, design, tools and machine models. 

Prerequisites  
CGTech Licensing:  
NX Model Interface 
 
Spatial: 
Spatial iop2020 installed  
 
Supported file extensions: 
.prt (single and assembly) 
 
 
Versions tested: 
Siemens NX 11 - Siemens NX CR 1899  
 
 

Installation - Configuration 
For the Siemens NX Spatial Model Interface, no user configuration is required.  

The Interface requires the below files are setup correctly, note that this setup is 
done by the VERICUT installer. 

• Spatial folder installed C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\spatial (translator) 

• C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\commands\acisenv.bat (mapping file) 

• The Model interface files are located at C:\Program 
Files\CGTech\VERICUT x.x.x\windows64\vericut\cgtacis_nx.dll 
(application) 

Ref: Overview of CGTech NX Interface Products  NX Products 
 

Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries 
(Microsoft Redistributables). The Microsoft Redistributable 
InstallDSSoftwareVC11Prerequisites_x86_x64.msi Installer is also available for 
download at: https://support.microsoft.com/en-ca/help/2977003/the-latest-
supported-visual-c-downloads  

file://xserve.cgtech.local/fileserver/CGTech/Tech_Tools/INTERNAL_USE_ONLY/Interfaces/NX_model/Documentation
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Usage 
Open > Model File: 

 
 
NOTE: The Interface Checks Out a license when the model is imported and then 
the Interface Checks In the license when the user checks it in or VERICUT is 
closed 
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Siemens NX Reader Interface  
The Siemens NX Reader Model Interface enables VERICUT to read the designated model 
file formats and use them as stock, fixture, design, tools and machine models.  

Prerequisites  
CGTech Licensing:  
NX Interface 
 
Spatial: 
Not used 
 
Supported file extensions: 
.prt (single and assembly) 
 
 
Versions tested: 
Siemens NX 11 - Siemens NX CR 1953   
 

Installation - Configuration 
For the Siemens NX Reader Model Interface, the Interface requires the below are 
setup correctly, note that this setup is done by the VERICUT installer. 

• NX is installed on the same computer you are running VERICUT on (same 
version as file being imported) 

• The following NX licenses are needed: gateway, cam_base, assemblies, 
adv_assemblies 

• Remove NX Model Interface license from the license file or VERICUT will 
use the Siemens NX Spatial Model Interface to import the model 

• Set environment variable UGII_BASE_DIR (example: C:\Program 
Files\Siemens\NX1899). Ref: vericut.bat (if exist "%UGII_BASE_DIR%" set 
path=%UGII_BASE_DIR%\NXBIN;%PATH%) 

• The Model interface files are located at C:\Program 
Files\CGTech\VERICUT x.x.x\windows64\vericut\nxinterface.dll 
(application) 

Ref: Overview of CGTech NX Interface Products  NX Products 
Note: environment variable CGTECH_USE_NXINTERFACE, which forces using 
nxinterface.dll for import if set to “true”, “yes”, or “1” (case insensitive). 
 

file://xserve.cgtech.local/fileserver/CGTech/Tech_Tools/INTERNAL_USE_ONLY/Interfaces/NX_model/Documentation
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Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries 
(Microsoft Redistributables). The Microsoft Redistributable 
InstallDSSoftwareVC11Prerequisites_x86_x64.msi Installer is also available for 
download at: https://support.microsoft.com/en-ca/help/2977003/the-latest-
supported-visual-c-downloads 
 

Usage 
Open > Model File: 

 
 
NOTE: The Interface Checks Out a license when the model is imported and then 
the Interface Checks In the license when VERICUT is closed 

 
 

 

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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SolidWorks Interface  
The SolidWorks Model Interface enables VERICUT to read the designated model file 
formats and use them as stock, fixture, design, tools and machine models.  

Prerequisites  
CGTech Licensing:  
SolidWorks Model Interface 
 
Spatial: 
Spatial iop2020 installed 
 
Supported file extensions: 
.SLDPRT 
.SLDASM 
 
Versions tested: 
SolidWorks 2016 - 2020   
 
 

Installation - Configuration 
For the SolidWorks Model Interface, no user configuration is required.  

The Interface requires the below files are setup correctly, note that this setup is 
done by the VERICUT installer. 

• Spatial folder installed C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\spatial (translator) 

• C:\Program Files\CGTech\VERICUT 
x.x.x\windows64\commands\acisenv.bat (mapping file) 

• The Model interface files are located at C:\Program 
Files\CGTech\VERICUT x.x.x\windows64\vericut\cgtacis_sw.dll 
(application) 

 

Microsoft Redistributables 
The interface may require the Install of Windows C++ run-time libraries 
(Microsoft Redistributables). The Microsoft Redistributable 
InstallDSSoftwareVC11Prerequisites_x86_x64.msi Installer is also available for 
download at: https://support.microsoft.com/en-ca/help/2977003/the-latest-
supported-visual-c-downloads  

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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Usage 
Open > Model File: 

 
 
NOTE: The Interface Checks Out a license when the model is imported and then 
the Interface Checks In the license when VERICUT is closed 

 
 

 

Return to “Other Configuration Tasks” 
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Commuter Tool 
The "CGTech Commuter Tool" is a utility to check out\in (borrow) licenses.  A commuter 
license allows users to borrow a license from their license server to continue to use 
VERICUT while away from their own network.  Or when they need or forced to work 
offline.   

Commuter licenses can be borrowed for a max of 14 days, and it will be subtracted from 
number of licenses that are available on the license server.  

Commuter licenses can be checked back in any time before the borrow expiration time.  
Expired borrowed license will be automatically checked into the license server.   

 Installation 
1. Run commuter_tool_install.exe 

2. Step through install (NOTE: Administrator rights are required.) 

a. Select language 

 
b. License Panel 
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c. Install Location Panel 

 
d. Program Menu Group Panel 
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e. Shortcuts Panel 

 
f. Install… Panel 
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g. Post-install (lsinit.exe check) Panel 

 
h. Complete Panel  
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CGTech Commuter Tool 
Run commuter tool from start window  

 
or from Desktop icon 

 

 
Server Host Name 

Specify the server host name or the IP address.  
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Load Feature 

Loads the license keys that are allowed to be commuted. 

License keys that are not allowed to be commuted will gray out. 

 
Checking Out Features 

This bottom checks out all the different license keys that a user selected Enter the Host 
Name. 

 
Days 

Specifies the number of days a license can be selected, minimum 1 maximum of 14.  

 

Update LSHOST 

This will update [VERICUT Install Directory]\windows64\commands\cgtenv.bat file to 
include the line: "set LSFORCEHOST=no-net" 

NOTE: Once a commuter license is checked out it will be unavailable on network License 
Server for the remainder of the days that it was checked out for or until it is manually 
checked back in to the network License Server.  
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Checking In Features 

Allows user to manually check in borrowed unexpired licenses.  

[VERICUT Install Directory]\windows64\commands\cgtenv.bat file will be reverted back 
to its original state if all CGTech commuter licenses have been checked back into the 
server. 

NOTE: If borrowed license Expired user will have to manually edit [VERICUT Install 
Directory]\windows64\commands\cgtenv.bat file or use the Specify License Sever 
Computer from the CGTECH VERICUT Utility xx menu in Windows Start menu  

s 
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